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About this manual
• 	This user manual is specially designed to detail the computer’s 

functions and features.

• 	The user manual supplied with the computer may vary 
depending on the model.

• 	Please read this manual before using the computer to ensure 
safe and proper use.

• 	Optional items, some devices and software referred to in the 
user manual may not be provided or subject to upgrades. 
Note that the computer environment referred in the user 
manual may not be the same as your environment.

• 	Descriptions are based on the computer’s default settings 
and Windows 8.1 operating system. Available features and 
additional services may vary by computer or operating 
system.

• 	This user manual describes procedures for using the 
touchpad, mouse, and touch screen. Instructions for using the 
touch screen are for models with the touch screen feature.

• 	Images and screenshots are those of the representative model 
of the series and may differ in appearance from the actual 
product.

• 	Content may differ from the final product and is subject to 
change without prior notice. For the latest version of the 
manual, refer to the Samsung website, www.samsung.com.

http://www.samsung.com
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Copyright
© 2014 Samsung Electronics Co., Ltd.

This manual is protected under international copyright laws.

No part of this manual may be reproduced, distributed, translated, 
or transmitted in any form or by any means, electronic or 
mechanical, including photocopying, recording, or storing in any 
information storage and retrieval system, without the prior written 
permission of Samsung Electronics.

Computer specifications or the contents of this manual may 
be changed without prior notice due to an upgrade of the 
computer’s functions.

Instructional icons and 
expressions

Warning: situations that could cause injury to yourself or 
others

Caution: situations that could cause damage to the 
computer or other equipment

Note: notes, usage tips, or additional information

The order of options or menus you must select to perform 
a step. For example, select the Settings charm → Power 
(represents select the Settings charm and then Power).

Select Click or touch. For example, when using a mouse or 
touchpad, select Settings means click Settings. When 
using a touch screen, it means touch Settings.
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HDMI, the HDMI logo, and the 
term High Definition Multimedia 
Interface are trademarks or 
registered trademarks of HDMI 
Licensing LLC.

As an ENERGY STAR® Partner, 
Samsung has determined that this 
product meets the ENERGY STAR® 
guidelines for energy efficiency.

• 	The ENERGY STAR Program has reduced greenhouse gas 
emissions and saved energy through voluntary labeling.

• 	Power management setting of this product have been 
enabled by default, and have various timing settings from  
1 minute to 5 hours. 

• 	The product can wake with a button press on the chassis from 
sleep mode.

Trademarks
• 	Samsung and the Samsung logo are trademarks or registered 

trademarks of Samsung Electronics.

• 	Intel and Core are trademarks or registered trademarks of the 
Intel Corporation.

• 	Microsoft, MS-DOS, and Windows are trademarks or registered 
trademarks of the Microsoft Corporation.

• 	Bluetooth® is a registered trademark of Bluetooth SIG, Inc. 
worldwide.

• 	Wi-Fi®, Wi-Fi Protected Setup™, Wi-Fi Direct™, Wi-Fi 
CERTIFIED™, and the Wi-Fi logo are registered trademarks of 
the Wi-Fi Alliance.

• 	All other trademarks and copyrights are the property of their 
respective owners.
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Product capacity representation

Storage capacity representation
The capacity of the storage device (HDD, SSD) of the manufacturer 
is calculated assuming that 1KB=1,000 Bytes.

However, the operating system (Windows) calculates the storage 
device capacity assuming that 1KB=1,024 Bytes, and therefore the 
capacity representation of the HDD in Windows is smaller than 
the actual capacity due to the difference in capacity calculation. 
For example, for an 80GB HDD, Windows represents the capacity 
as 74.5GB, 80x1,000x1,000x1,000 byte/(1,024x1,024x1,024)byte = 
74.505GB.

In addition, the capacity representation in Windows may be even 
smaller because some programs such as Recovery may reside in a 
hidden area of the HDD.

Memory capacity representation
The memory capacity reported in Windows is less than the actual 
capacity of memory. This is because BIOS or a video adapter uses 
a portion of memory or claims it for further use. For example, 
for 1GB(=1,024MB) memory installed, Windows may report the 
capacity as 1,022MB or less.

Caution for the data
Samsung Electronics shall not be liable for any data loss. Please 
take care to avoid losing any important data and back up your 
data to prevent any such data loss.

Operating system and software 
support
If you change the product’s factory OS (Operating System) to 
another OS or if you install software which is not supported by the 
product’s original factory OS, you will not receive any technical 
support, product exchange or refund, and a fee will be charged 
when requesting a service.

Please use your computer with the original factory OS. If you 
install an OS other than the factory OS, data may be deleted or the 
computer may not start.

Recommended screen resolutions
The recommended screen resolution for Windows is “FHD”  
(1,920x1,080) and for Windows 8.1 is “QHD+” (3,200x1,800).

If you set the resolution higher than the recommended value, it 
may result in problems with some applications, due to limitations 
of the operating system.
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Getting started

Layout
• 	Features or options may differ depending on the model.

• 	The items marked as optional may not be provided or 
may be provided in different locations.

• 	Since some space on the SSD is reserved for system 
recovery and operations, the displayed capacity of the 
SSD may be less than the actual capacity.

Front view
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Number/Name Description

LCD/Touch screen 
(optional)

• 	Displays the user interface.

• 	Recognizes touches on the screen. 
(Only for models with the touch 
screen.)

Power button • 	Press to turn the computer on.

Touchpad
• 	Move the cursor and click options.

• 	Works actions as those of a 
mouse.

Keyboard
• 	A device to enter data by pressing 

the keys.

Microphone • 	Use the built-in microphone.

Camera indicator 
light

• 	Indicates the camera status.

Number/Name Description

Camera

• 	Takes photos or videos.

• 	Use the camera application on 
the Start screen to take photos or 
videos.

Light sensor

• 	This sensor detects the ambient 
illumination of the computer. 
If the ambient illumination 
becomes dark, the LCD becomes 
dimmer and the keyboard 
backlight is lit. On the contrary, 
if the ambient illumination 
becomes brighter, the LCD 
becomes brighter and the 
keyboard backlight is turned off.

• 	Do not cover the sensor. 
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Number/Name Description

Power LED 
• 	Turns on when the computer is 

turned on.

Charge LED 

• 	This shows the power source and 
the battery charge status.

–– Red: Charging

–– Green: Fully charged

–– Blue: Turned on

–– No color: AC adapter not 
connected

Operating indicator light

2

1
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Number/Name Description

Monitor port 

• 	Connect external display devices 
that support a 15-pin analog 
connector.

• 	You can connect a VGA adapter 
(optional).

Ear-set/Headset 
jack 

• 	This is the jack for connecting an 
earset or headset.

USB 3.0 port • 	Connect a USB device.

Slim security slot 
• 	Secure the computer by 

connecting an optional lock and 
cable to it.

Right view

1 2 3 4
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Number/Name Description

DC jack 
• 	Connect the AC adapter to supply 

the power to the computer.
Chargeable USB 
3.0 port (optional) 

• 	Connect and charge a USB 
device.

Micro HDMI port 

• 	Used to connect an micro HDMI 
cable to an external device.

• 	You can enjoy digital video 
and audio by connecting the 
computer to a TV.

Wired LAN port 

• 	Connect an Ethernet cable to 
this port when connecting to 
the Internet via a wired LAN. 
Use a LAN adapter (optional) to 
connect to a wired LAN.

Memory card slot • 	Insert a memory card into the 
slot.

Left view

1 2 3 4 5

About the chargeable USB port
• 	It may take longer to charge the battery when charging a USB 

device.

• 	The battery power level may be reduced when charging a USB 
device while the computer is powered by the battery.

• 	The charging status of the USB device is not displayed on the 
computer.

• 	To turn on the chargeable function while the computer is 
turned off:

Open the Settings application and select Power 
Management → USB Charging → ON.

• 	This feature may not be available with some USB devices.
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Number/Name Description

Fan vents

• 	The internal heat of the computer is 
emitted through these holes.

• 	If the vents are blocked the 
computer may overheat. Avoid 
blocking the vents as this may be 
dangerous.

Internal battery

• 	Provides power to the computer 
when not connected to an AC 
adapter.

• 	To remove or replace the internal 
battery, take it to the Samsung 
Service Center. You will be charged 
for this service.

Speaker • 	A device used to generate sound.

After replacing the bottom of the computer, the model 
name, serial number and some logos on will no longer 
be present. For more information, contact the Samsung 
Service Center to request assistance.

Bottom view

1

2
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3	 Plug the power cable into an electric socket.

1

23

Connecting the AC adapter
Charge the battery before using it for the first time. Use the AC 
adapter to charge the battery.

• 	Use only Samsung-approved AC adapters, batteries, 
and cables. Unapproved adapters or cables can cause 
the battery to explode or damage the computer.

• 	Incorrectly connecting the charger may cause serious 
damage to the computer.

To restore the battery power after cutting it, connect the 
AC adapter.

1	 Connect the power cable to the AC adapter.

2	 Connect the AC adapter to the DC jack of the computer.
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4	 After charging, disconnect the AC adapter from the computer.

5	 Unplug it from the electric socket.

• 	This computer is equipped with an internal battery.  
The battery is not user-serviceable or user-replaceable.

• 	To have battery removed or replaced safely, take the 
device to a Samsung Service Center. You will be charged 
for this service.

• 	You can use the computer while it is charging, but 
the battery charging time may increase. If the battery 
temperature rises too much, the charging may stop as a 
safety measure.

When charging is complete, the charge status turns green.

Status

• 	Red: Charging

• 	Green: Fully charged

• 	No color: AC adapter not connected
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Battery usage time
Batteries are replacement items and over time the battery’s 
capacity to hold a charge and its power level is reduced. If a 
battery can only hold its charge for half of the time that it could 
when new, it is recommended to purchase a new, replacement 
battery.

When not using the battery for extended periods, charge the 
battery to 30-40% of full charge before storing it. This extends 
battery life.

Battery status
Move the cursor over the battery icon on the taskbar to view the 
current battery charge when disconnecting the AC adapter from 
the computer.

10:00 AM
1/1/2014

5 hr 21 min (64%) remaining

ENG

Viewing the current battery charge when the 
computer is turned off
Connect or disconnect the AC adapter from the computer to view 
the current battery charge when the computer is turned off.

10:00
2013/7/1
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3	 The computer turns on automatically when the LCD panel is 
opened.

If the computer does not turn on automatically, press the 
Power button.

Set the device not to turn on the computer automatically 
when the LCD panel is opened.

1. �On the Start screen, click  at the lower-left of the 
screen and select Settings.

2. Select General → Auto Booting → OFF.

Turning the computer on and off

Turning on

1	 Before turning on the computer, charge the battery.

2	 Open the LCD panel.
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Turning off

Turning off on the desktop

1	 To select the Start button, do one of the following: 

• 	Touch screen: Touch and hold the Start button ( ) at the 
lower-left edge of the desktop.

• 	Mouse: Right-click the Start button ( ) at the lower-left 
edge of the desktop.

2	 Select Shut down or sign out → Shut down.

• 	Save all the data before turning off the computer.

• 	Since the procedures to turn the computer off may 
differ depending on the installed operating system, 
please turn the computer off according to the 
procedures for the purchased operating system.

4	 Activate Windows by following the on-screen instructions.

• 	The Windows activation screen appears only when turning 
on the computer for the first time.

• 	The computer’s date and time may be incorrect when you 
turn it on for the first time. They may also be incorrect if the 
battery has been fully discharged or removed. To set the 
date and time, go to the desktop taskbar and right-click 
the clock area. Then, click Adjust date/time and set the 
current date and time

• 	To adjust the brightness of the screen, see LCD 
brightness.

• 	To adjust the sound, see Volume.
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Turning off on the Charms

1	 To open the Charms, do one of the following:

• 	Touch screen: Swipe inward from the right edge of the 
touch screen.

• 	Touchpad/Mouse: Move the cursor to the upper- or lower-
right edge of the screen.

Start Start

2	 Select the Settings charm → Power → Shut down.

Turning off on the Start screen

1	 Select Power ( ) at the upper-right corner of the Start 
screen.

Start

2	 Select Shut down.
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Unlocking the screen
To unlock the lock screen, do one of the following:

• 	Touch screen: Swipe the lock screen from bottom to top.

• 	Mouse: Click the lock screen.

• 	Keyboard: Press any key.

• 	Touchpad: Tap the touchpad.

10:00
Wednesday, January 1

If the account has a password, enter the password to log in after 
unlocking the screen.
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Help+Tips
On the Start screen, select Help+Tips. 

Start

You can control Windows menus with the mouse or with gestures.

Windows
Microsoft Windows is an operating system that is used to control 
a computer. For optimal use of the computer, learn how to use the 
operating system properly. It is best to learn how to use Windows 
by using Windows Help and Support, and Help+Tips.

• 	Images and available features may differ depending on 
the model and operating system.

• 	This manual is designed for Windows 8.1 and content 
may differ depending on the OS version.

• 	The image displayed on the desktop screen may differ 
between models and OS versions.

Help
To access the help, do one of the following:

• 	Keyboard: Press the F1 key.

• 	Touch screen: Swipe inward from the right edge of the touch 
screen to open the Charms and select the Settings charm → 
Help.

• 	Mouse: Move the cursor to the upper- or lower-right edge of 
the screen to open the Charms and select the Settings charm 
→ Help.
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Basics

Touch screen (optional)
Only use fingers to use the touch screen.

Touch screen gestures

Swiping
• 	To open the Charms, swipe from the right edge of the touch 

screen to the middle.

Start

• 	To open the most-recently used application, swipe from the 
left edge of the touch screen to the middle.

Start

• 	To bring up the app commands, swipe downwards from the 
top edge of the touch screen or swipe upwards from the 
bottom edge of the touch screen.

Start Start

or
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• 	To close an application, swipe downward from the top edge 
to the bottom edge of the touch screen.

• 	To view all installed applications, swipe upwards on the Start 
screen.

Start

• 	To switch from the applications screen to the Start screen, 
swipe downward on the applications screen.
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Double-tapping
To zoom in a part or double-click an item, double-tap on the 
touch screen.

Tapping and holding
To perform the right-clicking function, tap and hold an item on 
the touch screen.

• 	To scroll up, down, left or right, swipe with two fingers on the 
touch screen.

or

Tapping
To open an application, select a menu item, press an on-screen 
button, or enter a character using the on-screen keyboard, tap it 
with a finger on the touch screen.
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Pinching
To zoom in, spread two fingers apart on a website, map, or image. 
Pinch to zoom out.

Dragging
To move an icon, app tile, or preview to a new location, touch and 
hold it, and then drag it to the target position on the touch screen.
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• 	Leaving the touch screen idle for extended periods 
may result in afterimages (screen burn-in) or ghosting. 
Turn off the touch screen when you do not use the 
computer.

• 	Touch the touch screen with clean and dry hands. 
Remove the moisture from your hands and the touch 
screen surface before use.

• 	Avoid contacting the computer with a foreign 
substance. Doing so may cause the touch screen to 
malfunction.

• 	Very light touches on the touch screen may not be 
recognized.

• 	On the touch screen, press over an item precisely.

• 	The touch screen sensors are located at the edges of 
the touch screen. Therefore, do not cover the edges of 
the touch screen with protective covers or accessories.

• 	Touch screen gestures are available for touch screen 
models running Windows and work only with some 
applications.

• 	Do not apply a severe impact to the touch screen or 
press it with a sharp object. Doing so may damage the 
touch screen.

• 	Do not allow the touch screen to come into contact 
with other electrical devices. Electrostatic discharges 
can cause the touch screen to malfunction.

• 	Do not allow the touch screen to contact water. The 
touch screen may malfunction in humid conditions or 
when exposed to water.

• 	Do not spray liquid cleansing solutions directly onto the 
touch screen. The solution may enter the touch screen 
or cause undesired operation. To clean the screen, 
dampen a cloth with the solution and wipe the screen 
gently. Do not use solutions or cloths that contain 
abrasive materials, as they may damage the touch 
screen.

• 	Do not damage the edges of the touch screen. Doing so 
may damage the touch screen.
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1	 On the desktop, open the Charms and then select the 
Settings charm → Control Panel → Hardware and Sound → 
Tablet PC Settings → Calibrate....

Calibrating the screen
Calibrate the touch settings to make the screen sense accurately 
when using a finger.

This feature may differ or may not be available depending 
on the operating system.
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Entering text
Use the virtual keyboard to enter text.

To open the virtual keyboard, select  on the taskbar.

• 	Text entry is not supported in some languages. To 
enter text, change the input language to one of the 
supported languages.

• 	Enter text with the keyboard when using the computer 
for a long time.

2	 Select Yes when a pop-up appears.

3	 Touch  on the calibration screen.

• 	  appears sequentially from the upper-left to the lower-
right on the screen. Touch  each time it appears.

• 	To return to the last calibration point, right-click or touch 
and hold anywhere.

• 	To close the calibration screen, press the Esc key.

4	 When finishing calibrating and a pop-up appears, select Yes.
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Number Description

• 	Delete a preceding character.

• 	Break to the next line.

• 	Enter uppercase. For all caps, press and hold it.

• 	Change the keyboard layout.

• 	Move the cursor.

• 	Enter a space.

• 	Enter emoticons.

• 	Enter numerals and punctuation marks.

Changing the keyboard layout
To change the keyboard layout, touch  and select one of the 
following:

• 	 : Simplified Qwerty keyboard.

• 	 : Split Qwerty keyboard for entering text with two hands.

• 	 : Standard Qwerty keyboard.

8
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Copying and pasting

1	 Touch and drag your finger across the text to select it.

2	 Touch and hold the text to open the options pop-up.

3	 Touch Copy or Cut.

4	 Touch and hold a text input field and then touch Paste.

Entering uppercase
Touch  before entering a character. For all caps, touch it twice.

Changing language keyboards
Add keyboards to enter text in other languages. Open the Charms 
and select the Settings charm → Change PC settings → Time 
and language → Region and languages → Add a language →  
a language → Add.

Handwriting
Touch  → , write a word with a finger, and then touch 
Insert.

To view the handwriting help, touch .

Handwriting is not supported in some languages.
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• 	Press the Fn Lock key. When the Fn Lock key LED turns on, 
press a hot key.

→

When the Fn Lock key is on, hot keys are activated without 
pressing the Fn key.

Using hot keys
To use keyboard hot keys, do one of the following:

• 	Hold down the Fn key and press a hot key.

+

Keyboard
Enter text or access computer functions with the keyboard.

• 	Images and available features may differ depending on the model and operating system.

• 	The keyboard layout may differ depending on the country.
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Key/Icon Description

F7   
• 	Volume Control: Adjust the volume level.

F8

F9
• 	Keyboard backlight: Turn the keyboard 

backlight on or off.

F10
• 	Hide the screen or window by decreasing the 

brightness of the display.

F11
• 	Turn off the camera and sound recorder 

to prevent unauthorized access and illegal 
recording.

F12 • 	Wi-Fi: Turn a Wi-Fi network on or off.

Fn + 

• 	Right-click: Perform the right-click function.

• 	Open the app commands of the selected 
application on the Start screen. 

If the hot keys do not work properly, install the Settings 
application.

Hot key functions

Key/Icon Description

F1 • 	Settings: Launch the Settings application. 

F2 • 	Screen brightness control: Adjust the 
brightness level.F3

F4

• 	LCD/External monitor: Switch between the 
LCD and an external display device when an 
external display device is connected to the 
computer.

F5
• 	Touchpad: Turn on or off the touchpad 

function.

F6 • 	Mute: Mute or unmute the audio.
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Windows hot keys
Use hot keys to access functions conveniently in Windows.

Press the Windows key ( ) or the Alt key, and a hot key 
simultaneously.

Key Description

Windows key ( )
• 	Switch to the Start screen or the 

most recent application.

Windows key ( )+D • 	Switch to the desktop.

Windows key ( )+C • 	Open the Charms.

Windows key ( )+L • 	Lock the screen.

Windows key ( )+U • 	Open Ease of Access Center.

Windows key ( )+P
• 	Opens the project menu (external 

display connection) in the Devices 
charm.

Windows key ( )+X • 	Open advanced management tools.

Alt+F4
• 	Close a running application.

• 	To use this function, the Fn Lock key 
must be turned off. 
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Clicking function
Tap the touchpad or press the left touchpad button.

or

Tap

Click

Double-clicking function
Double-tap the touchpad or press the left touchpad button twice.

or

Tap-tap

Click-click

Touchpad
Use the touchpad to move the cursor or select an item. The left 
and right buttons of the touchpad act the same as the left and 
right buttons of a mouse.

• 	Use the touchpad only with fingers. The touchpad will 
not recognize actions of other objects. 

• 	Images and the touchpad layout may differ depending 
on the model.

Basic touchpad functions

Moving
To move the cursor, move a finger on the touchpad.
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Gesture functions

Swiping
• 	To open the Charms, swipe from the right edge of the 

touchpad to the middle.

• 	To open the most-recently used application, swipe from the 
left edge of the touchpad to the middle.

Right-clicking function
To right-click an item, press the right touchpad button.

Click

Dragging function
To move an icon or an app tile to a desired location, press and hold 
it and then drag it to the target position with the left touchpad 
button pressed.
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Pinching
To zoom in, spread two fingers apart on a website, map, or image. 
Pinch to zoom out.

Gesture functions using three or more fingers on the 
touchpad are not available.

• 	To scroll up, down, left or right, swipe with two fingers on the 
touchpad.

or
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LCD brightness
Adjust the LCD brightness to reduce eye strain and save power.

Controlling with keyboard
• 	To dim the LCD screen, hold down the Fn key and press the  

F2 key.

+

• 	To brighten the LCD screen, hold down the Fn key and press 
the F3 key.

+

Configuring touchpad gestures
Configure touchpad gestures to use the touchpad more efficiently.

Open the Charms and then select the Settings charm → Control 
Panel → Hardware and Sound → Touchpad → desired options.

To cancel touchpad gestures, deselect check boxes for the 
corresponding options in the Touchpad window.

Some options in the touchpad settings may not be 
available depending on the model.

Touchpad lock
Hold down the Fn key and press the F5 key. You can lock the 
touchpad.

+
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Changing display mode
Set the optimal conditions for the screen, based on the activity.

1	 On the Start screen, select .

2	 Select Settings.

3	 Select Display → Display Color → an option.

• 	Adapt Display: Optimizes the screen automatically for the 
currently running program.

• 	Dynamic: Makes scenes more vivid and clear.

• 	Standard: Appropriate for normal environments and 
convenient for most situations.

• 	Photo Editing: Appropriate for viewing photos.

• 	Reading mode: Appropriate for reading documents.

Controlling with Charms
Open the Charms, select the Settings charm → , and drag the 
slider.

• 	The LCD screen is set to the brightest level 
automatically when the AC adapter is connected. The 
LCD screen gets dimmer automatically when the AC 
adapter is disconnected to preserve battery power.

• 	The computer has an automatic screen brightness 
adjustment to extend the battery usage time. When 
necessary, the screen brightness is gradually adjusted. 
To turn off this function, right-click any area on the 
desktop and set at Graphics Properties. 
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• 	To mute or unmute the volume, hold down the Fn key and 
press the F6 key.

+

Controlling with Charms
Open the Charms, select the Settings charm → , and drag the 
slider.

Volume
Adjust the system volume or sound volume when playing music 
or video.

Controlling with keyboard
• 	To turn down the volume, hold down the Fn key and press the 

F7 key.

+

• 	To turn up the volume, hold down the Fn key and press the  
F8 key.

+
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Learning the BIOS screen
The BIOS setup screen appears as shown below.

Aptio Setup Utility - Copy (C) 2012 American Megatrends, Inc.

System Date >
System Time >

SATA Port 1    XXXX

CPU Vender    XXXX
CPU Type Core   XXXX
CPU Speed    XXXX
CPU VT (VT-x)   XXXX

Total Memory    XXXX

BIOS Version    XXXX
MICOM Version   XXXX

3

Number Name

• 	Setup items

• 	Setup tools

–– Help: View the help for BIOS set up.

–– Default: Return to default settings.

–– Restore: Cancel changes.

–– Save: Save settings.

–– Exit: Exit BIOS setup.

• 	Help

Setup utility (BIOS)
Define a boot password, change the boot priority, or configure the 
installed chipsets.

• 	Incorrect settings may cause the system to malfunction 
or crash.

• 	The BIOS setup screens, menus, and items may appear 
differently depending on the model and BIOS version.

• 	BIOS setup functions are subject to upgrades.

Entering the BIOS screen

1	 Turn on the computer.

2	 Before the Samsung logo (Samsung ATIV) appears, press the 
F2 key several times.

• 	If the computer is password-protected, press the F2 key 
several times before the password screen appears.

• 	If the password screen or the Windows start screen 
appears, restart the computer and try again.
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BIOS setup keys

Key Description

 / • 	Change values.

 / • 	Move to another menu.

Enter • 	Select an item or enter a sub-menu.

Space • 	Change the slide button.

Esc
• 	Return to a higher level menu or to the Exit 

menu.

F1 • 	View the setup help.

F3 • 	Load the previous settings.

F9 • 	Load the default settings.

F10 • 	Save changes and exit the BIOS setup.

Number Name
• 	Setup menu

–– SysInfo: View the basic specifications of 
the computer.

–– Advanced: Configure the chipsets and 
additional functions.

–– Security: Configure security functions. 

–– Boot: Configure peripherals and 
boot-related settings.

• 	The BIOS setup screen appears only in English.

• 	When using a keyboard, only certain keys will control 
the BIOS setup screen.
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Setting passwords
There are three password settings available; Supervisor Password, 
User Password, and HDD Password.

• 	Supervisor Password (low security level): This password is 
required when turning on the computer or attempt to enter 
the BIOS setup.

• 	User Password (low security level): This password is required 
to enter the BIOS setup. This password will be deactivated 
automatically if the Supervisor Password is disabled.

• 	HDD Password (high security level): This password is required 
to access the hard disk drive (HDD) from another computer. 
This password may not be supported, depending on the 
model.

Boot password
Setting a password with the BIOS enhances protection against 
viruses and hacking attacks.

• 	Do not forget your password or expose it to others. 

• 	If you forget the Supervisor Password or HDD 
Password, request assistance from the service center. In 
this case, a service fee will be charged.  

• 	When you forget the User Password, disable the 
Supervisor Password, and the User Password is also 
automatically disabled.  
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6	 Enter the password again to confirm it and select Ok.

7	 Select Save → Yes to save and restart.

• 	To enable the Password on boot option, set a 
Supervisor Password and enter the password when 
starting up the computer.

• 	To change the HDD Password after setting it, restart 
the computer.

• 	For some models, when the password entered message 
appears in the Setup Notice window, select Ok to 
complete the setup.

Setting a boot password

1	 Turn on the computer.

2	 Before the Samsung logo appears, press the F2 key several 
times.

3	 Access the Security menu.

4	 Select a password type (Supervisor Password, User 
Password, or HDD Password).

If you cannot select an item or the HDD Password Frozen 
message appears, restart the computer. Then, press the F2 key 
several times before the Samsung logo appears to enter the 
BIOS setup screen.

5	 Enter a password and select Ok.

The password can be up to 20 characters.
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Boot priority
Change the boot priority from the BIOS setup.

1	 Turn on the computer.

2	 Before the Samsung logo appears, press the F2 key several 
times.

3	 Access the Boot menu.

4	 Select Boot Device Priority.

5	 Click an option menu to open the list.

6	 Select an option.

7	 Select Save → Yes to save and restart.

Select Exit → Yes to restart without saving the changes.

To boot to DOS when using a bootable USB device, enter 
the BIOS setup. Then, select the Boot menu, and set the 
Fast BIOS Mode item to Off.

Removing a password

1	 Turn on the computer.

2	 Before the Samsung logo appears, press the F2 key several 
times.

3	 Access the Security menu.

4	 Select a password type (Supervisor Password, User 
Password, or HDD Password).

5	 Enter the current password and select Ok.

6	 Without entering any characters, select Ok → Ok.

For some models, to cancel the password, select Cancel in 
the Setup Notice window.
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3	 Select Advanced → Smart Battery Calibration.

Aptio Setup Utility - Copy (C) 2012 American Megatrends, Inc.

Smart Battery Calibration >

CPU Power Saving Mode   On

Touch Pad Mouse    On
USB Charge In Sleep Mode   Off

USB S3 Wake-up    Off

4	 The Battery Calibration function is activated and the battery  
is forcefully discharged. To stop the operation, press the <Esc> 
button.

This operation requires 3~5 hours depending on the battery 
capacity and the remaining battery charge.

Using the Battery Calibration Function
When charging/discharging the battery repeatedly for a short 
time only, the battery usage time may be reduced by the 
difference between the actual battery charge and the remaining 
charge display.

In this case, the actual battery charge and the remaining charge 
display will be the same by discharging the battery completely 
using the Battery Calibration function, and then recharging it 
again. 

The screen images and terms may differ from actual 
product depending on the computer model and driver 
version. 

1	 Disconnect the AC power adapter after turning off the 
computer.

2	 Turn the computer back on, and press the F2 key to enter the 
Setup screen.
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Network & Internet

Wired LAN
To access the Internet at home, set up an account with an Internet 
service provider (ISP). To purchase Internet service and a modem, 
contact a local ISP.

• 	Some features or procedures may differ depending on 
the model.

• 	These descriptions are written for Windows 8.1, so some 
figures and descriptions may differ from your operating 
system. Since the procedures for other Windows 
operating systems are similar, use the computer 
referring to these descriptions.

Wired LAN

1	 Connect a LAN adapter to the wired LAN port of the 
computer.

2	 Connect the LAN cable to the LAN adapter.
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5	 Select Internet Protocol Version 4 (TCP/IPv4) from the list of 
network settings → Properties.

• 	The Network Component name may differ depending on 
the operating system Installed.

• 	To add a network item such as a client, service, or protocol, 
select Install under the list of network items.

3	 On the desktop, open the Charms and select the Settings 
charm → Control Panel → Network and Internet → 
Network and Sharing Center → Change adapter settings.

4	 Right-click Ethernet and select Properties.

The LAN device name may differ depending on the 
computer’s network device.
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Wake on LAN (WOL) feature
Activate the system remotely from sleep mode when a signal, 
such as a magic packet command, is received via a wired LAN.

1	 On the desktop, open the Charms and select the Settings 
charm → Control Panel → Network and Internet → 
Network and Sharing Center → Change adapter settings.

2	 Right-click Ethernet and select Properties.

3	 Select Configure… → Power Management → Allow this 
device to wake the computer → OK.

4	 Restart the computer.

• 	If the computer wakes up from sleep mode inadvertently, 
disable the Wake on LAN feature.

• 	This feature may not work while using other power saving 
features. To disable other sleep functions, select the 
Settings charm → Control Panel → Hardware and Sound 
and then set Power Options.

6	 Configure the IP settings.

• 	When using DHCP, select Obtain an IP address 
automatically.

• 	When not using DHCP, contact the network administrator 
for the IP address. To use a static IP address, select Use the 
following IP address and set the IP address manually.

7	 Select OK to save the settings.
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Wireless LAN
Connect the computer to a wireless network to use the Internet.

The descriptions below are for computer models with 
a Wireless LAN card or device. A Wireless LAN device is 
optional. The pictures in this manual may differ from the 
actual product depending on the wireless LAN device 
model.

About Access Point (AP)
An Access Point (AP) is a network device that bridges wired 
and wireless LANs and corresponds to a wireless hub in a wired 
network. Multiple devices can be connected to an AP.

• 	When connected to a 100Mbps/1Gbps wired LAN , a 
message appears informing the user of connection to 
a 10Mbps/100Mbps wired LAN when the computer 
wakes from sleep mode. This happens because 
restoring the network takes about 3 seconds. When the 
network is restored, the computer will be connected to 
the 100Mbps/1Gbps LAN.

• 	When the system is running on battery power, it may 
take a few seconds for the connection to be established 
when connecting a LAN cable. This is the result of 
power saving features designed to reduce battery 
consumption.

• 	When the system is running on battery power, the 
speed of a wired LAN is decreased automatically 
to reduce battery consumption. In this case, a 
1Gbps/100Mbps LAN would function at the speed of a 
100Mbps/10Mbps connection.
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2	 Select a network from the list of detected wireless networks 
→ Connect automatically → Connect.

Networks

Connect automatically

Connect

Airplane mode

Off

Wi-Fi

On

View Connection Settings

3	 Enter a password, if necessary, and select Next.

Once the computer has been connected to a wireless 
network, it will attempt to connect to it automatically when 
it is available. For the network key, please ask the network 
administrator.

Wi-Fi networks

1	 Open the Charms and then select Settings charm → .

Networks

Wi-Fi

On

AP List

Airplane mode

Off

View Connection Settings
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Airplane mode
Airplane mode disables all wireless functions on the computer. 
Only non-network services are available in Airplane mode.

To turn on Airplane mode, open the Charms and select the 
Settings charm → , and then select the Airplane mode switch.

• 	This computer uses a non-harmonized frequency and 
is intended for use in all European countries. The WLAN 
can be operated in the EU without restriction indoors, 
but cannot be operated outdoors.

• 	Turn off the WLAN feature when not in use to save 
battery power.
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Applications

Using applications
Applications include the software that make up the 
operating system. Windows provides basic applications for 
frequently-performed tasks.

• 	Some applications are available only in Windows 8.1 
desktop mode.

• 	Images and features may differ depending on the 
model and the application version.

• 	Third-party software related services  
For descriptions about and service requests for 
third-party applications, please contact the relevant 
manufacturer. Some troubleshooting actions in 
response to service requests may not work depending 
on the application manufacturer.

• 	Applications that are provided by Samsung can be 
installed from SW Update.

• 	Some applications may not be supported depending 
on the model. 
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Menu Description

General • 	Set general settings.

System 
Optimization

• 	Set system optimization settings.

Power Management • 	Set power related settings.

Network • 	Set network functions and settings.

Display • 	Set the screen brightness and color.

Audio • 	Set sound effect settings.

Input • 	Set input functions and settings.

Security • 	Set security functions and settings.

Settings
Settings, a Samsung integrated settings application, offers various 
settings functions.

Images and features may differ depending on the model 
and the application version.

1	 On the Start screen, click  at the lower-left edge, and select 
Settings.

2	 Select an option to configure the corresponding function.
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2	 Read and agree to the User Agreement.

This step appears only when the application runs for the first 
time.

3	 Select Install & Update.

4	 Select items to update → OK.

Software Update
Install and update Samsung applications and drivers on the 
computer easily and conveniently. This application enables the 
user to search for or download the BIOS, drivers, and applications 
over the Internet. Keep the computer performing better and more 
stably with SW Update.

• 	To check for available updates, the computer must be 
connected to the Internet.

• 	Only applications that have been installed with this 
application can be updated.

• 	Images and features may differ depending on the 
model and the application version.

1	 On the Start screen, click  at the lower-left edge, and select 
SW Update.
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1	 On the Start screen, click  at the lower-left edge, and select 
Support Center.

2	 Select Resolve to correct the problems.

Support Center
Diagnose the performance, security, and status of the computer 
and fix any problems it may have. Additionally, access the FAQ and 
search features to find solutions for the problems.

• 	The Support Center application may not be provided 
or may be a different version depending on the model.

• 	Images and features may differ depending on the 
model and the application version.
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Using ATIV Help

1	 On a smartphone, tap ATIV Help.

2	 On the ATIV HELP main screen, select the desired menu.

3	 Select a menu and then a desired topic from the available 
content that appears.

You may incur additional charges when you access 
content.

ATIV Help (Self-help application 
solutions)
Use ATIV Help to access help-related content for Samsung 
computers from a smartphone.

Watch the ATIV Help videos to become familiar with new functions 
or to find solutions to problems.

ATIV Help videos are available on 
Samsung Tomorrow’s YouTube page 
(http://www.youtube.com/samsungnotebook).

Installing ATIV Help

1	 On a smartphone, tap Play Store and search for ATIV Help.

2	 Tap Install → Agree to complete the setup.

http:/www.youtube.com/samsungnotebook
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Menu Description

Samsung Utilities
• 	Launch software provided for 

Samsung computers.

Quick Starter
Use Quick Starter to easily launch frequently used software from 
the desktop.

• 	Quick Starter may not be available or the application 
version may differ depending on the model.

• 	The features and icon images may differ depending on 
the model.

1	 On the taskbar, click Quick Starter ( ).

2	 Quick starter launches.

Menu Description

Start menu

• 	The start menu used in this device 
is similar to the start menu used in 
earlier versions of Windows 8.1.

• 	Use the start menu to easily access 
various programs or settings, or to 
turn off the computer.
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Playing another video while playing the 
current video file

1	 Right-click on the screen, or swipe downwards from the top 
edge.

A list of videos will appear at the top of the screen.

2	 Select a video to play.

S Player+
A variety of file types, including multimedia formats, are available 
with S Player+.

1	 On the Start screen, select S Player+.

2	 Click to play a file.

Only files in the Video or Music folder are available for 
playback. Move the selected file to a corresponding folder.

• 	Move any subtitle files to the Video or Music folder.

• 	Some files may not be played properly depending on 
the encoding type.
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Step 1: Initializing the TPM chip
When using the TPM solution for the first time or registering a user 
again, initialize the TPM chip.

• 	Initializing the TPM chip deletes all authentication data 
on the chip.

• 	If the TPM chip is initialized after the security solution is 
configured, decrypting any existing folders or files that 
have been encrypted by the security solution may not 
be possible. Failure to do so may lead to inaccessibility 
to the folder and files after initialization. 

1	 Turn on the computer.

2	 Before the Samsung logo (Samsung ATIV) appears, press the 
F2 key several times.

3	 Access the Security menu.

4	 Select TPM Configuration.

5	 Set TPM Device to Enabled or On.

TPM security solution (optional)
Protect the user’s personal information by saving user 
authentication data on a Trusted Platform Module (TPM) chip 
installed in the computer.

• 	Images and features may differ depending on the 
model and the application version.

• 	Refer to the security solution help for more information.

• 	This function is only supported for models with TPM 
(security chip).

Configuring the security solution
To use the TPM security solution, initialize the TPM chip in the BIOS 
Setup, initialize the TPM solution, and then register a user. To use 
the TPM function, complete the following steps.
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Step 2: Installing the TPM solution
Install the TPM solution according to the procedures below.

• 	Descriptions are based on the SW Update.

• 	This solution is provided only for models with Recovery 
or the SW Update application. 

1	 Run SW Update.

2	 Select All Software.

3	 Select TPM Host SW → Install.

If the system software media is supplied with the product, 
install the application by using the system software media. 
(only when supplied)

4	 Follow the on-screen instructions to complete the registration, 
and restart the computer.

6	 Set TPM State to Clear.

7	 Select Save.

The computer restarts.

8	 Before the Samsung logo (Samsung ATIV) appears, press the 
F2 key several times.

9	 On the BIOS setup screen, access the Security menu.

10	Select TPM Configuration.

11	Set TPM State to Enable & Activate.

12	Select Save.

The computer restarts.
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3	 When the initialization wizard window appears, click Next.

• 	As recommended by the initialization wizard, backup 
your emergency recovery file to an external storage 
device to use the TPM more safely.

• 	If the status not initialized message appears, select 
Yes.

Step 3: Registering a user
Register a user according to the procedures below.

1	 Right-click  on the taskbar.

2	 Run the Security Platform Management item with the 
admin authority, click the User Settings tab, and initialize the 
settings.

The security authentication settings begin with the 
Initialization Wizard.
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• 	The virtual drive is in the following location.4	 Select a Security Platform Feature to use and set a basic user 
password.

5	 Follow the on-screen instructions to complete the user’s 
registration.

• 	When a user is registered with the TPM, they are able to 
encrypt files and folders by using the encryption system. 
Registered users can also use files and folders that are 
about to be encrypted by creating or copying them to the 
virtual drive.
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2	 Select the files or folders to encrypt and select OK.

The dialog box shown below appears only when the folder is 
encrypted.

Encrypting folders and files
Encrypt folders and files with the Encrypting Files System (EFS). 
EFS is available for the following operating systems:

• 	Windows 7 Professional / Enterprise / Ultimate

• 	Windows 8 Pro / Enterprise

• 	Windows 8.1 Pro / Enterprise

1	 Right-click a folder or file and then select Encrypt.
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4	 The color of the encrypted folder or name of the encrypted 
file changes to green.

Decrypting folders and files
Right-click an encrypted folder or file and then select Decrypt.

3	 When the user authentication window appears, enter 
the Basic User Password you entered when the user was 
registered and select OK.
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If the virtual drive (PSD) is not loaded
To use the virtual drive (PSD), the virtual drive (PSD) should be 
loaded first. To load a PSD, follow the procedures below.

1	 On the taskbar, right-click Security Platform ( ).

2	 Select Personal Secure Drive → Load.

3	 In the load window, enter the basic user password and click 
OK.

4	 On the taskbar, open File Explorer ( ) to confirm that the 
Personal Secure Drive has been created.

If confidential data has been copied to the PSD, the 
original data files are not encrypted.

Using the virtual drive (Personal Secure 
Drive)
The virtual drive is a space to save and manage confidential data. 
In the created virtual drive (PSD), it is possible to create files and 
folders as with a normal drive and to use confidential data saved 
on another drive by copying the data to the virtual drive (PSD).

If the virtual drive (PSD) does not appear
You can only use the virtual drive (PSD) if the Personal Secure 
Drive (PSD) option was selected during the TPM’s registration. If 
the PSD option was not selected during registration, complete the 
following steps.

1	 Right-click  on the taskbar.

2	 Run the Security Platform Management item with the admin 
authority and select Security Platform Configuration.

3	 When the initialization wizard window appears, click Next to 
select Personal Secure Drive (PSD) and then enter the user 
password.

4	 Follow the on-screen instructions to complete the settings.
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4	 Enter the password that you entered when registering with 
the TPM and select Next.

5	 Select Delete selected PSD → Next.

6	 Select I want to permanently delete my Personal Secure 
Drive without saving an unencrypted copy of its contents 
→ Next.

7	 Select Next → Finish.

The virtual drive is deleted.

Registering a new user to the security 
solution
To register an existing user, delete the existing authentication 
information saved on the TPM chip, and then clear the TPM chip.

Register the user in the following order.

Step 1: Deleting a virtual drive
If a virtual drive has been created, delete the virtual drive before 
deleting the existing authentication information saved on the TPM 
chip.

1	 On the taskbar, select  and right-click .

2	 Select Personal Secure Drive → Create/Manage.

3	 Select Next.
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7	 Select View → Options → View → Hidden files and folders.

8	 Select the Show hidden files, folders, and drives option and 
select OK.

9	 On the taskbar, select File Explorer ( ).

10	Select Local disk (C:) → ProgramData and delete Infineon 
folder.

The TPM security solution is deleted.

Step 3: Configuring the security solution (TPM)
To use the TPM security solution, see Configuring the security 
solution.

Step 2: Deleting authentication information
To delete the existing authentication information, uninstall the 
TPM security solution and delete the solution data.

1	 On the desktop, open the Charms and select the Settings 
charm.

2	 Select Control Panel → Programs → Uninstall a program.

3	 Select Infineon TPM Professional Package → Uninstall.

4	 When a message window appears, select Yes to remove the 
program.

5	 If the Infineon Security Platform message appears, select No.

6	 On the taskbar, select File Explorer ( ).
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External devices

External CD/DVD drive
This computer supports external CD/DVD drives with USB 
interfaces (optional). Check if the interface type of the external 
CD-ROM drive is a USB type.

Connecting the drive
Connect the drive to the USB port of the computer.

Inserting and ejecting a CD or DVD

1	 Press the Eject button to open the tray.

Number Description

• 	Emergency aperture

• 	Eject button

• 	Status indicator light

2	 Insert a CD or DVD.

3	 Push the tray inward until it clicks.

The status indicator turns on.
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• 	Do not insert warped, cracked, or heavily scratched 
disks. Doing so can damage the drive.

• 	Do not eject disks while the status indicator light is on.

• 	Your external drive may differ from the images used in 
this manual.

• 	If the drive will not open when the power is off, insert 
the end of a paper clip ( ) into the emergency 
aperture to open the tray manually.

• 	When cleaning a CD or DVD, wipe it with a soft cloth 
from the inside edge towards the outside edge.

• 	Reading and writing speeds may differ depending on 
the condition and type of media.

• 	A CD or DVD that is not in the shape of a circle is not 
recommended.
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• 	Some memory cards may not be fully compatible with 
the computer. Using an incompatible card may damage 
the computer or the memory card, or corrupt the data 
stored in it.

• 	Use caution to insert the memory card in the indicated 
direction.

• 	Store the card separately to prevent losing the card 
when moving the computer.

• 	Memory card speeds vary.

Memory card
Use a memory card to transfer data to other devices, such as 
digital cameras or MP3 players. Memory cards are sold separately. 
Purchase a memory card with the necessary capacity for the 
requirement. 

This computer supports the following types of memory cards.

Abbreviation Description

SD • 	Secure Digital

mini SD • 	mini Secure Digital

micro SD • 	micro Secure Digital

SDHC • 	Secure Digital High Capacity

mini SDHC • 	mini Secure Digital High Capacity

micro SDHC • 	micro Secure Digital High Capacity

SDXC • 	Secure Digital eXtended Capacity

micro SDXC • 	micro Secure Digital eXtended Capacity

To use a mini or micro card, insert the card into an adapter before 
inserting it into the memory card slot.
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3	 Select the pop-up message to open the memory card folder.

If a pop-up message appears, click the corresponding window 
→ Continue without scanning.

4	 Select Open folder to view files.

5	 Save, move, or delete data on the memory card.

The memory card folder opens only on the desktop.

Removing a memory card

Grasp the end of the card and pull it out of the slot.

Inserting a memory card

1	 If a dummy card or a memory card adapter is inserted in the 
memory card slot, remove it.

2	 Insert a memory card into the memory card slot in the 
indicated direction.

Use a memory card adapter to insert a micro memory card 
into the memory card slot.

For mini memory cards, use a mini card adapter.

A memory card adapter is an optional item and may not 
be provided with some models.
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• 	To use a memory card to exchange data with a digital 
device, such as a digital camera, formatting the data 
with the digital device is recommended.

• 	When trying to use a formatted memory card in 
another digital device, format the memory card again in 
the device.

• 	Inserting and removing a memory card repeatedly may 
damage the memory card.

• 	Secure Digital Input Output (SDIO) is not supported.

• 	If the write-protect tab is in the locked position, you 
cannot format, write, or delete data on the card.

Formatting a memory card
Format the memory card to remove all data or before using it for 
the first time.

Formatting a memory card deletes all data saved on 
the card. If necessary, back up important data before 
formatting the card.

1	 On the taskbar, select File Explorer ( ).

2	 Right-click the memory card drive, and then select Format.

3	 Select Start.
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Connecting to a display

1	 Connect the VGA cable or micro HDMI cable to the 
corresponding port of the computer.

When using a VGA cable, connect the VGA adapter to the 
computer first.

A VGA adapter is an optional item and may not be 
provided for some models.

External display
Connecting the computer to an external display device can be 
useful for presentations or when watching a movie. The cables 
required to connect an external display are sold separately. The 
computer supports either VGA or micro HDMI cables.

VGA cable Micro HDMI cable

• 	Check the available ports on the display device to 
ensure that it is compatible with the computer.

• 	If both types of ports are available, the micro HDMI port 
is recommended for better audio and video quality.

• 	An external display is not supported when using DOS or 
the Command Prompt window.

• 	Simultaneous output to all three (LCD + CRT + HDMI) is 
not supported depending on the model.



External devices

73

3	 Connect the power cord to the external display.

4	 Turn on the display and change its display mode to one that 
supports an external input.

5	 On the computer, open the Charms and select the Devices 
charm → Project → Second screen.

6	 Select a mode.

• 	  PC screen only: Show the interface on the computer 
monitor only.

• 	  Duplicate: Show the interface on both the computer 
and the external display.

• 	  Extend: Extend the screen to the external display.

• 	  Second screen only: Show the interface only on the 
external display.

Alternatively, on the desktop, open the Charms and select 
the Settings charm → Control Panel → Appearance and 
Personalization → Display → Change display settings 
→ Display → an option. For more information, refer to OS 
help.

2	 Connect the other end of the cable to the D-SUB port or HDMI 
port of the external display.

If the display has several HDMI ports, connect the cable to the 
DVI IN port.

<When using a VGA cable>

Monitor port

VGA adapter

D-SUB port

<When using a Micro HDMI cable>

Micro HDMI port HDMI port
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Slim security slot
Secure the computer to an object by connecting the security 
lock (optional) to the security slot. The security slot is designed 
for Samsung Security Locks only, which are sold separately. Other 
security locks will not fit in the slot.

Loop the Samsung Security Lock around a secure object and 
connect it to the security slot on the computer.

1

2
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Troubleshooting

Recover/Backup
When a problem occurs with the computer, it is possible to easily 
recover the computer back to the factory default settings by using 
the Recovery application (Recover/Backup). It is also possible 
to recover the computer to a previously backed up point. Back 
up important data regularly before a problem occurs with the 
computer.

• 	The Recovery application may not be provided in 
models with less than 64 GB of memory. For models 
with less than 64 GB of memory, recover the computer 
to the factory default settings by reinstalling Windows.

• 	Some functions may differ or may be unavailable, 
depending on the version. Refer to the application’s 
help for more information.

• 	Run the Recovery application with administrator 
privileges.

• 	CD/DVD drives are not supported by the Recovery 
application.

• 	Recovering the computer erases the data or 
applications saved after a backup point. Therefore, back 
up important data regularly before a problem occurs 
with the computer. 
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2	 Select Backup Management → Factory image → Recover.Recovering to factory default
Recover the computer to factory default settings. If necessary, 
back up important data to an external storage device before 
restoring the system. See Backing up the current system.

1	 When the computer starts Windows: On the Start screen, 
click  at the lower-left edge, and select Recovery.

When the computer does not start Windows: Turn on the 
computer and press the F4 key several times before the 
Samsung logo (Samsung ATIV) appears.
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Backing up the current system
Back up important data to an alternate internal drive or an 
external storage device regularly to prevent data loss.

1	 Select Backup Management → New backup.

3	 Select Recover.

4	 Follow the on-screen instructions to complete the recovery.
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Recovering after a backup
Select a backup point saved on an alternate internal drive or an 
external storage device to recover the computer to the point.

1	 When backing up to an external storage device, connect the 
device to the computer.

2	 On the Start screen, click  at the lower-left edge, and select 
Recovery.

2	 Select a drive from the drive list → Backup.

• 	When backing up to an external storage device, connect 
the device to the computer and then select the external 
drive.

3	 Follow the on-screen instructions to complete the backup.
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Copying the drive (making a disk image)
To replace the drive, move the data to the new drive by making a 
disk image. The new drive must be large enough to hold the data 
from the current drive.

Purchase an external hard drive connector separately to connect 
the new drive to the computer.

1	 Connect the new drive to the computer with an external hard 
drive connector.

2	 On the Start screen, click  at the lower-left edge, and select 
Recovery.

3	 Select Disk copy.

3	 Select Backup Management → a backup image → Recover.

4	 Follow the on-screen instructions to complete data recovery.
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5	 After the data is saved to another drive, open the cover at the 
bottom of the computer and replace the existing drive with 
the new one.

If the cover is difficult to open, contact the Samsung Service 
Center to request assistance. You will be charged for this 
service.

4	 Select a recovery point → Disk copy.

The data on the disk is copied to the new disk.
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Q&A
When experiencing problems with the computer, try these 
solutions.

Windows

Where is the Shut down button?

Touch screen:

• 	At the upper-right corner of the Start screen, select Power  
( ) → Shut down.

• 	Open the Charms and select the Settings charm → Power → 
Shut down.

• 	Touch and hold the Start button, and then select Shut down 
or sign out → Shut down.

Mouse:

• 	At the upper-right corner of the Start screen, select Power  
( ) → Shut down.

• 	Open the Charms and select the Settings charm → Power → 
Shut down.

• 	Right-click the Start button, and then click Shut down or sign 
out → Shut down.

Windows recovery function
If the Recovery application is not supported by the computer, 
recover system to  factory default settings using the recovery 
function of Windows.

Reinstalling Windows will erase all data saved on the 
computer. Back up application and personal data to an 
external storage device before reinstalling Windows.

1	 Open the Charms and select the Settings charm → Change 
PC settings → Update and recovery → Recovery.

2	 Select Get Started under Remove everything and reinstall 
Windows.

Select Get Started under Refresh your PC without affecting 
your files to recover the computer while keeping photos, 
videos, music files, and documents.

3	 Follow the on-screen instructions to proceed with the 
reinstallation.

After a recovery, on the Start screen, click  at the lower-
left edge, and select SW Update to install the necessary 
Samsung applications.
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How can I uninstall an application?

1	 On the desktop, open the Charms and select the Settings 
charm.

2	 Select Control Panel → Programs → Uninstall a program → 
an application → Uninstall.

Alternatively, right-click the Start button, and the select 
Programs and Features.

Select an application to uninstall → uninstall. 

My application disappeared from the Start screen. 
How can I correct this?

Touch screen:

1	 On the Start screen, swipe upward.

2	 All installed applications will appear.

3	 Touch and hold an application, and then select Pin to start. 

Mouse:

1	 On the Start screen, click  at the lower-left edge to view 
installed applications.

2	 Right-click an application, and then select Pin to start.
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How can I start my computer in DOS?
To start the computer in DOS via a USB device:

1	 Turn on the computer.

2	 Before the Samsung logo appears, press the F2 key several 
times.

3	 Select the Boot menu.

4	 Set Fast BIOS Mode to Off.

5	 Set Secure boot Control to Off.

6	 Set OS Mode Selection to CSM mode and then restart the 
computer.

How can I change the screen settings, environment 
settings, color, and so on?
Configure the lock screen, Start screen, and account picture by 
opening the Charms and selecting the Settings charm → Change 
PC settings → PC and devices. To configure any other features, 
on the desktop, open the Charms and select the Settings charm 
→ Control Panel.

Why am I unable to run Active X in Internet Explorer 
when I launch it on the Start screen?
The version of Internet Explorer that appears on the Start screen 
complies with HTML5 web standards, so it does not support Active 
X. Launch Internet Explorer on the desktop to view websites that 
require Active X.

Can I remove Windows 8 or Windows 8.1 and install a 
different operating system?
To install a different operation system on the computer, 
change the BIOS settings first. For more information, 
visit http://www.samsung.com → Customer support → 
Troubleshooting and search for Windows 8 or Windows 8.1.

http://www.samsung.com
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Why is the capacity representation of the hard disk 
drive (HDD) in Windows different from the product 
specifications?
The capacity of the storage device (HDD or SSD) of the 
manufacturer is calculated assuming that 1KB=1,000 Bytes. 
However, the operating system (Windows) calculates the storage 
device capacity assuming that 1KB=1,024 Bytes, and therefore the 
capacity representation of the HDD in Windows is smaller than 
the actual capacity. The capacity representation in Windows may 
be smaller than the actual capacity because some applications 
occupy a certain area of the HDD outside of Windows.

For models with the Recovery application, the HDD capacity 
representation in Windows may be smaller than the actual 
capacity because the Recovery application uses a hidden area of 
5-20 GB of the HDD to save the recovery image, and that hidden 
area is not counted towards the total size available to Windows. 
The size of the Recovery application varies by model.

Touch screen resolution

Text on the screen overlaps or looks small.
If the font size is set too large or small, text may not fit or may not 
be legible on the screen.

In this case, on the desktop, right-click any area and select 
Personalize → Display → an option under Change the size of all 
items → Apply → Sign out now.

Recovery

What is a Recovery Area?
The computer has an additional partition for restoring data 
or saving backup files (only for models with the Recovery 
application). This partition is called a Recovery Area and it 
includes a recovery image comprised of the operating system and 
applications.
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Miscellaneous

The camera and the microphone are not working. 
How do I turn them on again?
When the recording protect mode is activated, the camera and 
microphone will not work.

To turn off recording protect mode, hold down the Fn key and 
then press the F11 key.

The computer does not turn on automatically when 
the LCD panel is opened.
To turn on the computer, the LCD panel should be opened greater 
than a certain angle. 

The angle may differ depending on the model.

If the computer LED does not turn on automatically, press the 
Power button.

What is a recovery image?
This refers to specifications about the operating system, drivers, 
and software that are converted to a data image. It is required 
to recover the computer and is embedded in the computer’s 
HDD. However, this is not provided for storage devices where the 
capacity is less than 64 GB, due to their small capacities.

How can I recover a computer that does not have the 
Recovery application?
Recover the computer with the recovery function provided by 
Windows. Refer to the Recover Functionality item in the help for 
more details.
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Product specifications
The system specifications may differ depending on the derived 
models. For detailed system specifications, refer to the product 
catalogue.

Item Specification

CPU • 	Intel Core i5/i7 Processor

Main memory • 	Memory type: LPDDR3 SDRAM

Storage device • 	SSD

Graphics • 	Intel HD Graphics (Internal)

Operating 
environment

• 	Temperature: -5–40 °C for storage,  
10–35 °C when operating

• 	Humidity: 5–90 % for storage,  
20–80 % when operating

AC/DC rating
• 	Input: 100–240 VAC, 50–60 Hz

• 	Output: 19 VDC, 2.1 A

PC rating • 	19 VDC 2.1 A (40 W)

• 	Optional components may not be provided or different 
components may be provided depending on the 
model.

• 	The system specifications are subject to change without 
notice.

• 	The Storage device capacity of a computer in which 
Recovery is installed, is represented as smaller than the 
product specification.

• 	Replacement, addition, or upgrade of memory is 
unavailable for this computer hardware.

• 	The amount of memory that Windows can use may be 
smaller than the actual amount of memory available.
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• 	Use an adjustable chair with firm, comfortable support.

• 	Adjust the height of your chair so that thighs are horizontal to 
the floor and feet are flat on the floor.

• 	The back of the chair should support the lower back. Adjust 
the backrest to fit your body properly.

• 	Sit back fully in your chair and straighten the back and neck. 
Avoid leaning forward or craning your neck toward the 
computer screen.

• 	Avoid using the computer while lying down or on your lap. 
If the computer’s temperature increases, there is a danger of 
burn injury.

• 	The instructions in this manual have been prepared 
so that they can be applied to the range of needs of 
general users. If the user is not included in the range, 
the recommendations should be applied according to 
the user’s needs.

• 	Images may differ from actual products.

Ergonomic tips
Maintaining a proper posture during computer use is very 
important to prevent physical injury. Improper or prolonged 
keyboard use may result in repetitive strain injury. Viewing the 
monitor screen for extended periods of time may result in eye 
strain. Therefore, please follow these guidelines carefully when 
setting up and using the computer.

Back and neck
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• 	When using the keyboard and touchpad, the shoulders 
should be relaxed. The upper arm and forearm should form an 
angle that is slightly greater than a right angle, with the wrist 
and hand in almost a straight line.

• 	Use a light touch when typing or using the touchpad and 
keep the hands and fingers relaxed. Avoid rolling the thumbs 
under your palms or supporting the wrists on the desk while 
typing.

• 	Use an external keyboard and mouse when using the 
computer for long periods. When using an external keyboard 
and mouse, position the devices at the same height as the 
computer and within comfortable reach.

Arms and hands
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Hearing and volume control

VOLUME

Check your volume!

• 	Ensure that volume is not too loud before using headphones.

• 	Avoid using headphones for long periods of time.

• 	Default audio settings can be changed by software and driver 
updates without your knowledge. Always recheck equalizer 
and volume settings before listening to audio.

• 	To prevent possible hearing damage, do not listen at high 
volume levels for long periods.

Eye position and display illumination

50cm

• 	Position the screen at least 50 cm away from your eyes.

• 	Adjust the height of the screen so that its top edge is equal to 
or just below the level of your eyes.

• 	Avoid setting the screen’s brightness settings excessively high.

• 	Keep the screen clean.

• 	If wearing glasses, clean them before using the computer.

• 	When referring to printed content while typing, use a static 
paper holder to hold the paper at about the same height as 
the monitor.
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Operating conditions
• 	Take at least a 10 minute break every hour.

• 	Avoid using the computer in dark locations. Use the computer 
with as much ambient light as you would when reading a 
book.

• 	Indirect illumination is recommended. Use a curtain to 
prevent reflections and glare on the screen.

• 	While operating a computer and talking on the phone, use a 
headset. Using the computer while holding a phone on your 
shoulder or with your neck may lead to muscle strain or injury.

• 	Keep frequently used items within reach.

• 	Use the computer only within the temperature and humidity 
ranges specified in this manual.
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Power Indicator Light (LED)

Center Holes

220V Power Plug 110V Power Plug

Good Example O

Wrong Example X

Battery

Charging the battery on an airplane
Power outlets may vary by airplane. Choose the connection 
method that fits your circumstances.

The power plug and auto adapter figures may differ from 
the actual products.

Using an AC power plug
Insert the power plug pins into the center of the power outlet.

• 	If the pins are not inserted into the centers of the holes, they 
will not be fully connected. In this case, reconnect the power 
plug.

• 	You must insert the power plug when the power indicator 
light (LED) is lit green. If the plug is connected properly, the 
power indicator light remains green. 

Otherwise, the power indicator light turns off. In this case, 
disconnect the plug, verify that the power indicator light is 
green and then reconnect the power plug.
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Using an airplane charging converter
Depending on the type of airplane you are travelling on, use the 
auto adapter and charging converter. Insert the airplane power 
input jack into the airplane’s power outlet.

1	 Connect the auto adapter’s DC plug to the computer.

2	 Connect the airplane charging converter (optional) to the 
auto adapter (optional).

3	 Insert the airplane power input jack into the power outlet.

Auto adapter Charging converter

Power outlet of the airplane

DC plug Cigar plug DC jack
2

 

1

2

Using an auto adapter
When a 12VDC power supply is available a cigarette lighter socket 
will be provided. Use the optional auto adapter to use the 12VDC 
power supply.

1	 Insert the cigarette lighter plug of the auto adapter into the 
cigarette lighter socket.

2	 Connect the DC plug of the auto adapter to the power input 
port of the computer.

Auto adapter

Cigar socket of the airplane

DC plugCigar plug

2

1
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Warning

Failure to follow instructions marked with this symbol may cause 
personal injury and even fatality.

Installation related

15cm

Keep the computer at least 15 cm away from 
any object.

Failure to do so may result in computer 
malfunction or injury.

Do not place or use the computer on slanted or 
vibrating places.

Failure to do so may result in computer 
malfunction or damage.

To avoid danger of suffocation, keep the plastic 
bag away from infants and children.

Putting a plastic bag over the head may result in 
suffocation.

Safety precautions
This safety information relates to computer use. Some of the 
content may be not applicable to your computer. To prevent injury 
or damage to your computer, read the safety information before 
using it.

• 	Since this is commonly applied to Samsung Computers, 
some pictures may differ from actual products.

• 	The term “product,” as used in this manual, refers to 
basic components, such as the computer, battery, 
adapter and optional accessories provided by 
Samsung.

NP v3.7
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Connect the power cord to the AC adapter 
firmly.

Otherwise, there is a danger of fire due to an 
incomplete contact.

Use only the AC adapter supplied with the 
product.

Using another adapter may cause the screen to 
flicker. 

Use only properly earthed electric sockets or 
extension cords.

Connecting to unearthed electric sockets or 
extension cords does not protect users from 
earth faults. Unearthed electric sockets or 
extension cords may cause electric shock or fire.

If water or another substance enters the 
product, disconnect the power cord and 
contact the Samsung Service Center. For 
notebook computers that are provided with 
an external removable battery, separate the 
battery also.

Damage to the device within the computer may 
cause electric shock or fire.

Power related

The power plug and wall outlet figures may differ 
depending on the country specifications and the product 
model.

Handle the power cord with care.

• 	Do not touch with wet hands.
• 	Do not use a damaged or loose power 

cord.
• 	Use only specified voltage/capacity.
• 	Firmly insert the power cable into the AC 

adapter.
• 	Do not unplug the power cord by pulling 

the cable only.
• 	Unplug the wall-mount AC adapter 

(adapter and plug integrated type) from 
the wall outlet while holding the body and 
pulling it.

Failure to do so may result in electric shock 
or fire.
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Take care not to allow metal objects such as a 
key or clip to touch the battery terminal (metal 
parts).

This may cause excessive current and result in 
fire, burns, or damage to the battery.

If the product leaks, emits strange odors, or 
swells, immediately stop using the product and 
contact the Samsung Service Center.

Failure to do so may result in an explosion or fire.

To use the computer safely, replace a dead 
battery with a new, authorized battery.

When removing the real time clock (RTC) 
battery, keep it away from infants and children.

If a child swallows the battery, the child may 
suffocate. If this happens, immediately contact a 
doctor.

Keep the power cord or outlet clean with a dry 
towel so that they are not covered with dust.

Failure to do so may result in electric shock or 
fire.

Do not bend or damage the power cable or 
the AC adapter with a heavy or sharp-edged 
object.

A damaged cable or cord may result in electric 
shock or fire.

Battery usage related

Keep the battery, AC adapter, and the power 
cord away from infants and pets.

Failure to do so may result in electric shock or 
computer malfunction.

Use only Samsung-approved battery and AC 
adapter.

Batteries or AC adapters that are not approved 
by Samsung may malfunction from a defective 
safety device, resulting in an explosion or fire.
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Never heat the product or put the product 
into a fire. Do not put or use the product in a 
hot location such as a sauna, inside a vehicle 
exposed to heat, and so on.

There is a danger of explosion or fire.

Before cleaning the computer, disconnect all 
the cables that are connected to the computer. 
For notebook computers that are provided 
with an external removable battery, separate 
the battery also.

Failure to do so may result in electric shock or 
fire.

Keep the product away from water or liquid.

Water or liquid entering the computer may cause 
a short circuit inside the product, resulting in 
electric shock or fire.

Usage related

Do not use the computer on heated floors or 
electric pads, or on beds, blankets, or cushions 
that block the ventilation of the computer.

In these environments, be careful not to block 
the vent of the computer, which is normally at 
the side or bottom of the computer. A blocked 
vent causes the computer to overheat, resulting 
in an explosion, fire, burns, or computer 
malfunction.

Do not use the computer in very damp 
locations such as a bathroom.

Failure to do so may result in computer 
malfunction or electric shock. Use the computer 
within the recommended temperature and 
humidity range (10–35 °C, 20–80 % RH).
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Follow all instructions as specified in the user 
manual.

Do not disassemble any other parts by yourself. 
Failure to do so may result in computer 
malfunction, electric shock, or fire.

Do not disassemble the power supply unit, 
the AC adapter, or the battery under any 
circumstances.

Failure to do so may result in electric shock, fire, 
or an explosion.

Shut down the computer and disconnect all 
cables before disassembling the computer. If 
the notebook is an external and removable 
battery type, remove the external battery.

Failure to do so, may cause electric shock.

If the product is dropped or broken, disconnect 
the power cord and contact the Samsung 
Service Center. For notebook computers that 
are provided with an external removable 
battery, separate the battery also.

Using a broken computer may result in electric 
shock or fire.

Do not touch the computer vents or the 
connected AC adapter for extended periods 
while the computer is on.

Contact with the vent or the connected AC 
adapter for extended periods may result in low-
temperature burns, such as redness on the skin.

Upgrade related

Do not attempt to upgrade the computer, 
unless you are qualified.

Contact the Samsung Service Center or an 
electrician.
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When carrying the notebook computer with 
other items, such as the adapter, mouse, books 
etc, take care not to press anything against the 
notebook computer.

If a heavy object is pressed against the notebook 
computer, a white spot or stain may appear on 
the LCD. Therefore, take care not to apply any 
pressure to the notebook.

In this case, place the notebook computer in 
a separate compartment away from the other 
objects.

Storage and movement related

Do not close the LCD panel and put the 
computer into a bag to move it when it is still 
turned on.

The computer may overheat and there is a 
danger of fire. Shut the computer down properly 
before moving it.

When using wireless communication (LAN, 
Bluetooth, etc) always follow applicable 
instructions. For example, airlines and 
hospitals have strict requirements.

Avoid exposing a drive to magnetic fields. 
Security devices with magnetic fields include 
airport walk-through devices and security 
wands. The airport security devices that check 
carry-on luggage, such as conveyor belts, 
use x-rays instead of magnetism and will not 
damage a drive.
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Do not place a heavy object over the product.

This may cause a problem with the computer. In addition, the 
object may fall and cause injury, or damage the computer.

Connect the power cord to a nearer consent when installing the 
computer.

If a problem occurs to the computer and disconnection from the 
consent is delayed, there is a danger of electric shock or fire.

Dispose of worn-out batteries properly.

• 	There is a danger of fire or explosion.

• 	The battery disposal method may differ depending on 
your country and region. Dispose of the used battery in an 
appropriate way.

Do not throw or disassemble the battery and do not put it into 
water.

This may cause an injury, fire or explosion.

Caution

Failure to follow instructions marked with this symbol may cause 
slight injury or damage to the product.

Installation related

Do not block the ports (holes), vents, etc. of the product and do 
not insert objects.

Damage to a component within the computer may cause electric 
shock or fire.

When using the computer with it lying on its side, place it so 
that the vents face upwards.

Failure to do so, may cause the internal temperature of the 
computer to rise and the computer to malfunction or halt.
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Usage related
Use the pen for its intended purpose only.

Using the pen improperly may cause physical injury.

Do not place a candle, light cigar, etc. over or on the product.

There is a danger of fire.

Make sure to have the product tested by a safety service 
engineer after repairing the product.

Authorized Samsung Repair Centers will carry out safety checks 
after a repair. Using a repaired product without testing it for safety 
may cause an electric shock or fire.

Use only a battery authorized by Samsung.

Failure to do so may cause an explosion.

Avoid contact with metal objects such as car keys or clips when 
keeping or carrying a battery.

Contact with a metal may cause excessive current and a high 
temperature and may damage the battery or cause a fire.

Charge the battery according to the instructions in the manual.

Failure to do so, may cause an explosion or fire from damage to 
the product.

Do not heat the product(or battery) or expose it to heat (e.g. 
inside a vehicle during the summer).

There is a danger of explosion or fire.
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Do not drop, hit, or apply excessive force to the computer.

Failure to do so may result in physical injury or data loss.

Do not touch the antenna with electricity facility such as the 
power outlet.

There is a danger of electric shock.

When handling computer parts, follow the instructions on the 
manual supplied with the parts.

Failure to do so, may cause damage to the product.

If the computer emits smoke, or there is a burning smell, 
disconnect the power plug from the wall outlet and contact 
the Samsung Service Center immediately. If the notebook is 
external, and removable battery type, remove the external 
battery.

There is a danger of fire.

Do not use a damaged or modified CD.

There is a danger of damaging the product or personal injury.

In case of lightning, immediately turn the system off, disconnect 
the power cord from the wall outlet and phone line from 
modem. Do not use a modem or phone.

There is a danger of electric shock or fire.

Connect only permitted devices to the connectors or ports of 
the computer.

Failure to do so, may cause electric shock and fire.

Close the LCD panel only after checking if the notebook 
computer is turned off.

The temperature may rise and it may cause deformation of the 
product.

Do not press the Eject Button while the CD-ROM drive is in 
operation.

You might lose data and the disk might be suddenly ejected and 
could cause an injury.
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Keep the product away from magnetic fields.

• 	Magnetic materials may cause the product malfunction or 
cause the battery to discharge.

• 	The magnetism in the computer may damage the information 
in the magnetic stripe cards such as credit cards.

Upgrade Related

Take care when touching the product or parts.

The device may be damaged or you may be injured.

Take care not to throw or drop a computer part or device.

This may cause injury or damage to the product.

Do not insert the fingers into the PC Card Slot.

There is a danger of injury or electric shock.

Use recommended computer cleansing solution when cleaning 
the product and only use the computer when it is completely 
dried.

Failure to do so may cause electric shock or fire.

Emergency disk eject method using paperclip should not 
be used while the disk is in motion. Make sure to use the 
emergency disk eject method only when the Optical Disk Drive 
has stopped.

There is a danger of injury.

Do not place your face close to the Optical Disk Drive tray when 
it is operating.

There is a danger of injury due to an abrupt ejection.
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Storage and movement related

Properly shut down, disconnect  and secure the computer 
cables before moving it.

Failure to do so may damage the computer or cause someone to 
trip over a loose cable.

For long periods of not using the notebook computer, discharge 
the battery and preserve as it is detached. (For external and 
removable battery type)

The battery will be preserved at its best condition.

Do not operate or watch the computer while driving a vehicle.

There is a danger of a traffic accident. Please concentrate on 
driving.

Make sure to close the computer cover before connecting the 
power after a reassembly.

There is a danger of electric shock if your body touches an internal 
part.

Use parts authorized by Samsung only.

Failure to do so, may cause fire or damage the product.

Never disassemble or repair the product by yourself.

If the computer serviced or repaired by an unqualified technician, 
the warranty will not cover the repair fees. There is a danger of 
accident. Use authorized Samsung Service Centers.

To connect a device that is not manufactured or authorized 
by Samsung, enquire at the Samsung Service Center before 
connecting the device.

There is a danger of damaging the product.
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Causes that may damage the data of a hard disk drive and the 
hard disk drive itself.

• 	The data may be lost when an external impact is applied to 
the disk while disassembling or assembling the computer.

• 	The data may be lost when the computer is turned off or reset 
by a power failure while the hard disk drive is operating.

• 	The data may be lost and irrecoverable due to a computer 
virus infection.

• 	The data may be lost if the power is turned off while running 
an application.

• 	Sudden impact or movement to the computer while the hard 
disk drive is operating, may cause files to be corrupted or bad 
sectors on the hard disk.

To prevent data loss due to damage to the hard disk drive, 
please back up the data frequently.

Cautions on preventing data loss (Hard disk 
management)

Take care not to damage the data on a hard disk drive.

• 	A hard disk drive is so sensitive to external impact that an 
external impact may cause loss of data on the surface of the 
disk.

• 	Take extra care, because moving the computer or an impact 
on the computer when it is turned on may damage the data 
of the hard disk drive.

• 	Samsung is not liable for any loss of data on the hard disk 
drive.



Appendix

105

LCD bad pixels principle of the computer
Samsung observes strict specifications regarding the quality 
and reliability of the LCD. However, there is a small chance that 
a few pixels may be bad. A large number of bad pixels can cause 
problems with the display, but a small number of bad pixels does 
not generally affect computer performance.

Samsung’s quality standards for bad pixels are as follows:

• 	Bright dot: 2 or fewer

• 	Black dot: 4 or fewer

• 	Combination (bright and dark): 4 or fewer

Cleaning the LCD screen
Clean the LCD screen with a soft cloth dampened with computer 
cleansing detergent. When cleaning the screen, move the cloth in 
one direction. Do not use excessive force. Doing so may damage 
the LCD screen.
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Setting up the system
• 	Read and follow all instructions marked on the product and 

in the documentation before operating the system. Retain all 
safety and operating instructions for future use.

• 	Do not use this product near water or a heat source such as a 
radiator.

• 	Set up the system on a stable work surface.

• 	The product should be operated only with the type of power 
source indicated on the rating label.

• 	Ensure that the electrical outlet to power the equipment is 
easily accessible in case of fire or short circuit.

• 	If the computer has a voltage selector switch, make sure that 
the switch is in the proper position for your area.

• 	Openings in the computer case are provided for ventilation. 
Do not block or cover these openings. Make sure you provide 
adequate space, at least 6 inches (15 cm), around the system 
for ventilation when setting up your work area. Never insert 
objects of any kind into the computer ventilation openings.

Important safety information

Safety instructions
The system is designed and tested to meet the latest standards for 
safety of information technology equipment. However, to ensure 
safe use of this product, it is important that the safety instructions 
marked on the product and in the documentation are followed.

Always follow these instructions to help guard against 
personal injury and damage to the system.
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Care during use
• 	Do not walk on the power cord or allow anything to rest on it.

• 	Do not spill anything on the system. The best way to avoid 
spills is to not eat or drink near the system.

• 	Some products have a replaceable CMOS battery on the 
system board. There is a danger of explosion if the CMOS 
battery is replaced incorrectly. Replace the battery with the 
same or equivalent type recommended by the manufacturer.

Dispose of batteries according to the manufacturers 
instructions. If the CMOS battery requires replacement insure 
that a qualified technician performs the task.

• 	When the computer is turned off, a small amount of electrical 
current still flows through the computer.

To avoid electrical shock, always unplug all power cables, 
remove the battery and modem cables from the wall outlets 
before cleaning the system.

• 	Ensure that the fan vents on the bottom of the casing are 
clear at all times. Do not place the computer on a soft surface, 
doing so will block the bottom vents.

• 	When using an extension cord with this system, make sure 
that the total power rating on the products plugged into the 
extension cord does not exceed the extension cord power 
rating.

• 	For Notebooks with glossy display bezels the user should 
consider the placement of the Notebook as the bezel may 
cause disturbing reflections from surrounding light and bright 
surfaces.
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The instruction on safety operation of the computer

1	 When installing and operating devices please refer to safety 
requirements in the user manual.

2	 Devices can be used only with the equipment specified in the 
technical specifications of the devices.

3	 If any smell of burning or smoke is detected from the 
computer the unit should be switched off and battery 
removed. The unit should be checked by a qualified 
technician before reuse.

4	 Service and repair of devices should be carried out by 
authorized service centers.

5	 Do not allow the portable computer to operate with the base 
resting directly on exposed skin for extended periods of time. 
The surface temperature of the base will rise during normal 
operation (particularly when AC Power is present). Allowing 
sustained contact with exposed skin can cause discomfort or 
eventually a burn.

• 	Unplug the system from the wall outlet and refer servicing to 
qualified personnel if:

–– The power cord or plug is damaged.

–– Liquid has been spilled into the system.

–– The system does not operate properly when the operating 
instructions are followed.

–– The system was dropped or the casing is damaged.

–– The system performance changes.
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Battery disposal
Do not put rechargeable batteries or products powered by 
non-removable rechargeable batteries in the garbage.

Contact the Samsung Service Center for information on how to 
dispose of batteries that you cannot use or recharge any longer. 
Follow all local regulations when disposing of old batteries.

THERE IS RISK OF EXPLOSION IF BATTERY IS REPLACED BY 
AN INCORRECT TYPE.

DISPORE OF USED BATTERIES ACCORDING TO THE 
INSTRUCTIONS.

Replacement parts and 
accessories
Use only replacement parts and accessories recommended by 
manufacturer.

To reduce the risk of fire, use only No. 26 AWG or larger 
telecommunications line cord.

Do not use this product in areas classified as hazardous. 
Such areas include patient care areas of medical and 
dental facilities, oxygen rich environments, or industrial 
areas.
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Connect and disconnect the AC adapter
The socket-outlet shall be installed near the equipment and shall 
be easily accessible.

Do not unplug the power cord by pulling the cable only.

Power cord requirements
The power cord set (all plug, cable and AC adapter plug) you 
received with your computer meets the requirements for use in 
the country where you purchased your equipment.

Power cord sets for use in other countries must meet the 
requirements of the country where you use the computer. For 
more information on power cord set requirements, contact your 
authorized dealer, reseller, or service provider.

Laser safety
All systems equipped with CD or DVD drives comply with the 
appropriate safety standards, including IEC 60825-1. The laser 
devices in these components are classified as “Class 1 Laser 
Products” under a US Department of Health and Human Services 
(DHHS) Radiation Performance Standard. Should the unit ever 
need servicing, contact an authorized service location.

• 	Laser Safety Note: Use of controls or adjustments or 
performance of procedures other than those specified 
in this manual may result in hazardous radiation 
exposure. To prevent exposure to laser beams, do not 
try to open the enclosure of a CD or DVD drive.

• 	Class 1M laser radiation when operating part is open. 
Do not view directly with optical instruments.

• 	Class 3B invisible laser radiation when open.  
Avoid exposure to the beam.
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Regulatory compliance 
statements

Wireless guidance
(If fitted with 2.4G band or 5G band)

Low power, Radio LAN type devices (radio frequency (RF) 
wireless communication devices), operating in the 2.4GHz/5GHz 
Band, may be present (embedded) in the notebook system. The 
following section is a general overview of considerations while 
operating a wireless device.

Additional limitations, cautions, and concerns for specific 
countries are listed in the specific country sections (or country 
group sections). The wireless devices in the system are only 
qualified for use in the countries identified by the Radio Approval 
Marks on the system rating label. If the country you will be using 
the wireless device in, is not listed, please contact your local Radio 
Approval agency for requirements. Wireless devices are closely 
regulated and use may not be allowed.

General requirements
The requirements listed below are applicable to all countries:

• 	All power cord sets must be approved by an acceptable 
accredited agency responsible for evaluation in the country 
where the power cord set will be used.

• 	The power cord set must have a minimum current capacity 
of 7A and a nominal voltage rating of 125 or 250 volts AC, as 
required by each country’s power system. (USA only)

• 	The appliance coupler must meet the mechanical 
configuration of an EN 60 320/IEC 320 Standard Sheet C7 
(or C5) connector, for mating with appliance inlet on the 
computer.
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• 	Radio frequency wireless communication can interfere 
with equipment on commercial aircraft. Current 
aviation regulations require wireless devices to be 
turned off while traveling in an airplane.  
802.11ABGN (also known as wireless Ethernet or Wi-Fi) 
and Bluetooth communication devices are examples of 
devices that provide wireless communication.

• 	In environments where the risk of interference to other 
devices or services is harmful or perceived as harmful, 
the option to use a wireless device may be restricted 
or eliminated. Airports, Hospitals, and Oxygen or 
flammable gas laden atmospheres are limited examples 
where use of wireless devices may be restricted or 
eliminated. When in environments where you are 
uncertain of the sanction to use wireless devices, ask 
the applicable authority for authorization prior to use or 
turning on the wireless device.

• 	Every country has different restrictions on the use of 
wireless devices. Since your system is equipped with 
a wireless device, when traveling between countries 
with your system, check with the local Radio Approval 
authorities prior to any move or trip for any restrictions 
on the use of a wireless device in the destination 
country. 

The RF field strength of the wireless device or devices that may 
be embedded in the notebook are well below all international 
RF exposure limits as known at this time. Because the wireless 
devices (which may be embedded into the notebook) emit less 
energy than is allowed in radio frequency safety standards and 
recommendations, manufacturer believes these devices are safe 
for use. Regardless of the power levels, care should be taken to 
minimize human contact during normal operation.

Some circumstances require restrictions on wireless devices.

Examples of common restrictions are listed on the next page:
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United States of America

USA and Canada Safety Requirements and Notices
Do not touch or move antenna while the unit is transmitting or 
receiving.

Do not hold any component containing the radio such that the 
antenna is very close to touching any exposed parts of the body, 
especially the face or eyes, while transmitting.

Do not operate the radio or attempt to transmit data unless the 
antenna is connected; if not, the radio may be damaged.

Use in specific environments:

The use of wireless devices in hazardous locations is limited by the 
constraints posed by the safety directors of such environments.

The use of wireless devices on airplanes is governed by the Federal 
Aviation Administration (FAA).

The use of wireless devices in hospitals is restricted to the limits 
set forth by each hospital.

• 	If the system came equipped with an internal 
embedded wireless device, do not operate the wireless 
device unless all covers and shields are in place and the 
system is fully assembled.

• 	Wireless devices are not user serviceable. Do not modify 
them in any way. Modification to a wireless device will 
void the authorization to use it. Please contact the 
manufacturer for service.

• 	Only use drivers approved for country in which the 
device will be used. See the manufacturer System 
Restoration Kit, or contact the manufacturer’s technical 
support for additional information.
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The Part 15 radio device operates on a non-interference 
basis with other devices operating at this frequency. Any 
changes or modification to said product not expressly 
approved by Intel could void the user’s authority to 
operate this device.

Unintentional emitter per FCC Part 15
This device complies with Part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) this device may not 
cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause 
undesired operation.

Explosive Device Proximity Warning

Do not operate a portable transmitter (such as a wireless 
network device) near unshielded blasting caps or in 
an explosive environment unless the device has been 
modified to be qualified for such use.

Use On Aircraft Caution

Regulations of the FCC and FAA prohibit airborne 
operation of radio-frequency wireless devices because 
their signals could interfere with critical aircraft 
instruments.

Other wireless devices

Safety notices for other devices in the wireless network:

Refer to the documentation supplied with wireless Ethernet 
adapters or other devices in the wireless network.
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If necessary, the user should consult the dealer or an experienced 
radio/television technician for additional suggestions. The user 
may find the following booklet helpful: “Something About 
Interference.”

This is available at FCC local regional offices. Our company is not 
responsible for any radio or television interference caused by 
unauthorized modifications of this equipment or the substitution 
or attachment of connecting cables and equipment other than 
those specified by our company. The correction will be the 
responsibility of the user. Use only shielded data cables with this 
system.

This equipment has been tested and found to comply 
with the limits for a Class B digital device pursuant to Part 
15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, 
and can radiate radio frequency energy. If not installed 
and used in accordance with the instructions, it may 
cause harmful interference. If this equipment does cause 
harmful interference to radio or television reception, 
which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

• 	Reorient or relocate the receiving antenna.

• 	Increase the separation between the equipment and 
receiver.

• 	Connect the equipment into an outlet on a circuit 
different from that to which the receiver is connected.

• 	Consult the dealer or an experienced radio/TV 
technician for help.



Appendix

116

Operation of this device is subject to the following two conditions:

(1) This device may not cause harmful interference, and (2) 
this device must accept any interference received, including 
interference that may cause undesired operation of the device.

Wireless devices are not user serviceable. Do not modify 
them in any way.

Modification to a wireless device will void the 
authorization to use it. Contact manufacturer for service.

Intentional emitter per FCC Part 15
(If fitted with 2.4 G band or 5 G band)

Low power, Radio LAN type devices (radio frequency (RF) wireless 
communication devices), operating in the 2.4 GHz/5 GHz Band, 
may be present (embedded) in the notebook system. This section 
is only applicable if these devices are present. Refer to the system 
label to verify the presence of wireless devices.

Wireless devices that may be in the system are only qualified for 
use in the United States of America if an FCC ID number is on the 
system label.

This device is restricted to indoor use due to its operation in the 
5.15 to 5.25 GHz frequency range. FCC requires this product to be 
used indoors for the frequency range 5.15 to 5.25 GHz to reduce 
the potential for harmful interference to co-channel Mobile 
Satellite systems. High power radars are allocated as primary users 
of the 5.25 to 5.35 GHz and 5.65 to 5.85 GHz bands. These radar 
stations can cause interference with and/or damage this device.
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RF exposure or SAR information can viewed on-line at http://www.
fcc.gov/oet/ea/fccid/. This site uses this product FCC ID number 
on the outside of the product. Sometimes it may be necessary to 
remove the battery pack to find number. Once you have the FCC 
ID number for a particular product, follow the instructions on the 
website and it should provide RF exposure information or values 
for typical or maximum SAR for particular product.

For corresponding model only

The Specific Absorption Rate (SAR) is a measure of the rate of 
absorption of RF energy by the human body expressed in units 
of watts per kilogram (W/kg). The FCC wireless devices to comply 
with a safety limit of 1.6 watts per kilogram (1.6W/kg).

SAR level of this device while operating can be well below the 
maximum value. This is because the device is designed to operate 
at multiple power levels so as to use only the power required to 
reach the network. In general, the closer you are to a wireless base 
station antenna, the lower the power output.

Health and safety information

Exposure to Radio Frequency (RF) Signals 
Certification Information
This product can contain an embedded radio transmitter and 
receiver. It is designed and manufactured not to exceed the 
exposure limits for radio frequency (RF) energy set by the Federal 
Communications Commission (FCC) of the U.S. government. These 
FCC exposure limits are derived from the recommendations of two 
expert organizations, the National Council on Radiation Protection 
and Measurement (NCRP) and the Institute of Electrical and 
Electronics Engineers (IEEE). In both cases, the recommendations 
were developed by scientific and engineering experts drawn from 
industry, government, and academia after extensive reviews of the 
scientific literature related to the biological effects of RF energy.

Before a new model is available for sale to the public, it must be 
certified to the FCC that it does not exceed the exposure limit 
established by the FCC. Evaluation per each model is performed 
in positions and locations (e.g. at the bottom on the body) as 
required by the FCC.

For body worn operation, this model meets the FCC RF exposure 
guidelines when used with Samsung accessory designated for this 
product. Non-compliance with the above restrictions may result in 
violation of FCC RF exposure guidelines.
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The term “IC” before the equipment certification number only 
signifies that the Industry Canada technical specifications were 
met. To reduce potential radio interference to other users, the 
antenna type and its gain should be so chosen that the equivalent 
isotropically radiated power (EIRP) is not more than that required 
for successful communication. To prevent radio interference 
to the licensed service, this device is intended to be operated 
indoors and away from windows to provide maximum shielding. 
Equipment (or its transmit antenna) that is installed outdoors is 
subject to licensing.

Canada

Unintentional emitter per ICES-003
This digital apparatus does not exceed the Class B limits for radio 
noise emissions from digital apparatus as set out in the radio 
interference regulations of Industry Canada.

Intentional emitter per RSS 210
This device complies with RSS 210 of Industry Canada. Operation 
is subject to the following two conditions: (1) this device may 
not cause interference, and (2) this device must accept any 
interference, including interference that may cause undesired 
operation of this device.
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When using IEEE 802.11a wireless LAN, this product is restricted to 
indoor use due to its operation in the 5.15 to 5.25 GHz frequency 
range. Industry Canada requires this product to be used indoors 
for the frequency range of 5.15 GHz to 5.25 GHz to reduce the 
potential for harmful interference to co-channel mobile satellite 
systems. High power radar is allocated as the primary user of the 
5.25 to 5.35 GHz and 5.65 to 5.85 GHz bands. These radar stations 
can cause interference with and/or damage to this device.

The maximum allowed antenna gain for use with this device 
is 6dBi in order to comply with the E.I.R.P limit for the 5.25 to 
5.35 and 5.725 to 5.85 GHz frequency range in point-to-point 
operation.

(If fitted with 2.4G band or 5G band)

Low power, Radio LAN type devices (radio frequency (RF) wireless 
communication devices), operating in the 2.4GHz/5GHz Band, 
may be present (embedded) in your notebook system. This 
section is only applicable if these devices are present. Refer to the 
system label to verify the presence of wireless devices.

Wireless devices that may be in your system are only qualified for 
use in Canada if an Industry Canada ID number is on the system 
label.
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Brazil
Este produto esta homologado pela ANATEL, de acordo com 
os procedimentos regulamentados pela Resolucao 242/2000, e 
atende aos requisitos tecnicos aplicados.

Este equipamento opera em caráter secundário, isto é, não 
tem direito a proteção contra interferência prejudicial, mesmo 
de estações do mesmo tipo, e não pode causar interferência a 
sistemas operando em caráter primário.

The power output of the wireless device (or devices), which may 
be embedded in your notebook, is well below the RF exposure 
limits as set by Industry Canada.

Operation of this device is subject to the following two conditions: 
(1) This device may not cause harmful interference, and (2) 
this device must accept any interference received, including 
interference that may cause undesired operation of the device.

To prevent radio interference to licensed service, this 
device is intended to be operated indoors and away from 
windows to provide maximum shielding. Equipment (or 
its transmit antenna) that is installed outdoors is subject to 
licensing.

Wireless devices are not user serviceable. Do not modify 
them in any way. Modification to a wireless device will 
void the authorization to use it. Contact manufacturer for 
service.
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European radio approval information (for products 
fitted with EU-approved radio devices)
This Product is a Notebook computer; low power, Radio LAN type 
devices (radio frequency (RF) wireless communication devices), 
operating in the 2.4GHz/5GHz band, may be present (embedded) 
in your notebook system which is intended for home or office use. 
This section is only applicable if these devices are present. Refer to 
the system label to verify the presence of wireless devices.

Wireless devices that may be in your system are only qualified for 
use in the European Union or associated areas if a CE mark  
with a Notified Body Registration Number and the Alert Symbol is 
on the system label.

The power output of the wireless device or devices that may be 
embedded in you notebook is well below the RF exposure limits 
as set by the European Commission through the R&TTE directive.

The low band 5.15 - 5.35 GHz is for indoor use only.

See 802.11b and 802.11g restrictions for specific countries 
or regions within countries under the heading “European 
Economic Area Restrictions” below.

European Union

European Union CE marking and compliance notices
Products intended for sale within the European Union are 
marked with the Conformité Européene (CE) Marking, which 
indicates compliance with the applicable Directives and European 
standards and amendments identified below. This equipment also 
carries the Class 2 identifier.

The following information is only applicable to systems labeled 
with the CE mark .

European Directives 
This Information Technology Equipment has been tested and 
found to comply with the following European directives:

• 	EMC Directive 2004/108/EC

• 	Low Voltage Directive 2006/95/EC

• 	R&TTE Directive 1999/5/EC

Samsung Electronics (UK) Ltd, Euro QA Lab. 
Blackbushe Business Park Saxony Way, Yateley,  
Hampshire GU46 6GG United Kingdom
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Nation Description

Eesti[Estonian]

Käesolevaga kinnitab 
Samsung seadme Notebook 
PC vastavust direktiivi 1999/5/
EÜ põhinõuetele ja nimetatud 
direktiivist tulenevatele teistele 
asjakohastele sätetele.

English

Hereby, Samsung, declares 
that this Notebook PC is in 
compliance with the essential 
requirements and other 
relevant provisions of Directive 
1999/5/EC.

Español[Spanish]

Por medio de la presente 
Samsung declara que el 
Notebook PC cumple con 
los requisitos esenciales 
y cualesquiera otras 
disposiciones aplicables 
o exigibles de la Directiva 
1999/5/CE.

EU R&TTE compliance statements

Nation Description

Česky[Czech]

Samsung tímto prohlašuje, 
že tento Notebook PC je ve 
shodě se základními požadavky 
a dalšími příslušnými 
ustanoveními směrnice 1999/5/
ES.

Dansk[Danish]

Undertegnede Samsung 
erklærer herved, at følgende 
udstyr Notebook PC overholder 
de væsentlige krav og øvrige 
relevante krav i direktiv 1999/5/
EF.

Deutsch[German]

Hiermit erklärt Samsung, dass 
sich das Gerät Notebook PC 
in Übereinstimmung mit den 
grundlegenden Anforderungen 
und den übrigen einschlägigen 
Bestimmungen der Richtlinie 
1999/5/EG befindet.
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Nation Description

Lietuvių[Lithuanian]

Šiuo Samsung deklaruoja, 
kad šis Notebook PC atitinka 
esminius reikalavimus ir 
kitas 1999/5/EB Direktyvos 
nuostatas.

Nederlands[Dutch]

Hierbij verklaart Samsung dat 
het toestel Notebook PC in 
overeenstemming is met de 
essentiële eisen en de andere 
relevante bepalingen van 
richtlijn 1999/5/EG.

Malti[Maltese]

Hawnhekk, Samsung, jiddikjara 
li dan Notebook PC jikkonforma 
mal-ħtiāijiet essenzjali u ma 
provvedimenti oħrajn relevanti 
li hemm fid-Dirrettiva 1999/5/
EC.

Nation Description

Ελληνική[Greek]

ΜΕ ΤΗΝ ΠΑΡΟΥΣΑ Samsung 
ΔΗΛΩΝΕΙ ΟΤΙ Notebook PC 
ΣΥΜΜΟΡΦΩΝΕΤΑΙ ΠΡΟΣ ΤΙΣ 
ΟΥΣΙΩΔΕΙΣ ΑΠΑΙΤΗΣΕΙΣ ΚΑΙ ΤΙΣ 
ΛΟΙΠΕΣ ΣΧΕΤΙΚΕΣ ΔΙΑΤΑΞΕΙΣ 
ΤΗΣ ΟΔΗΓΙΑΣ 1999/5/ΕΚ.

Français[French]

Par la présente Samsung 
déclare que l’appareil 
Notebook PC est conforme aux 
exigences essentielles et aux 
autres dispositions pertinentes 
de la directive 1999/5/CE.

Italiano[Italian]

Con la presente Samsung 
dichiara che questo Notebook 
PC è conforme ai requisiti 
essenziali ed alle altre 
disposizioni pertinenti stabilite 
dalla direttiva 1999/5/CE.

Latviski[Latvian]

Ar šo Samsung deklarē, ka 
Notebook PC atbilst Direktīvas 
1999/5/EK būtiskajām prasībām 
un citiem ar to saistītajiem 
noteikumiem.
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Nation Description

Slovensky[Slovak]

Samsung týmto vyhlasuje, že 
Notebook PC spĺňa základné 
požiadavky a všetky príslušné 
ustanovenia Smernice 1999/5/
ES.

Suomi[Finnish]

Samsung vakuuttaa täten 
että Notebook PC tyyppinen 
laite on direktiivin 1999/5/EY 
oleellisten vaatimusten ja sitä 
koskevien direktiivin muiden 
ehtojen mukainen.

Svenska[Swedish]

Härmed intygar Samsung 
att denna Notebook PC står 
I överensstämmelse med de 
väsentliga egenskapskrav och 
övriga relevanta bestämmelser 
som framgår av direktiv 
1999/5/EG.

Nation Description

Magyar[Hungarian]

Alulírott, Samsung nyilatkozom, 
hogy a Notebook PC megfelel 
a vonatkozó alapvetõ 
követelményeknek és az 
1999/5/EC irányelv egyéb 
elõírásainak.

Polski[Polish]

Niniejszym Samsung 
oświadcza, Ŝe Notebook PC 
jest zgodny z zasadniczymi 
wymogami oraz pozostałymi 
stosownymi postanowieniami 
Dyrektywy 1999/5/EC.

Português[Portuguese]

Samsung declara que este 
Notebook PC está conforme 
com os requisitos essenciais e 
outras disposições da Directiva 
1999/5/CE.

Slovensko[Slovenian]

Samsung izjavlja, da je ta 
Notebook PC v skladu z 
bistvenimi zahtevami in 
ostalimi relevantnimi določili 
direktive 1999/5/ES.



Appendix

125

To view the EU Declaration of Conformity for this product (in 
English only), go to: http://www.samsung.com/uk/support/main/
supportMain.do or http://www.samsung.com/uk/support then 
search the model number of the product.

If the Declaration of Conformity for the model you are interested 
in is not available on our web-site, please contact your distributor 
or below address.

doc.eu@samsung.com

Manufacturer information

Samsung Electronics Co., Ltd.

129, Samsung-Ro, Yeongtong-Gu, Suwon-City, Gyeonggi-Do, 443-
742, Korea

Samsung Electronics Suzhou Computer Co., Ltd.

No. 198, Fangzhou Road, Suzhou Industrial Park, Jiangsu Province, 
215021, China

Tel: +86-0512-6253-8988

Samsung Electronics Vietnam Co., Ltd.

Yen Phong 1, I.P Yen Trung Commune, Yen Phong Dist., Bac Ninh 
Province, Vietnam

For the web or the phone number of the Samsung Service Center, 
see the Warranty or contact the retailer where you purchased your 
product.

Nation Description

Íslenska[Icelandic]

Hér með lýsir Samsung yfir því 
að Notebook PC er í samræmi 
við grunnkröfur og aðrar kröfur, 
sem gerðar eru í tilskipun 
1999/5/EC.

Norsk[Norwegian]

Samsung erklærer herved 
at utstyret Notebook 
PC er i samsvar med de 
grunnleggende krav og øvrige 
relevante krav i direktiv 1999/5/
EF.

Türkiye[Türkçe]

Bu belge ile, Samsung bu 
Notebook PC’nin 1999/5/
EC Yönetmeliğinin temel 
gerekliliklerine ve ilgili 
hükümlerine uygun olduğunu 
beyan eder.

http://www.samsung.com/uk/support/main/supportMain.do
http://www.samsung.com/uk/support/main/supportMain.do
http://www.samsung.com/uk/support
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The European variant is intended for use throughout the European 
Economic Area. However, authorization for use is further restricted 
in particular countries or regions within countries, as follows:

General

European standards dictate maximum radiated transmit power 
of 100 mW effective isotropic radiated power (EIRP) and the 
frequency range 2400 – 2483.5 MHz.

The low band 5.15 - 5.35 GHz is for indoor use only.

European economic area restrictions

Local restriction of 802.11b/802.11g radio usage

Note to integrator: The following statements on local restrictions 
must be published in all end-user documentation provided with 
the system or product incorporating the wireless product.

Due to the fact that the frequencies used by 
802.11b/802.11g wireless LAN devices may not yet be 
harmonized in all countries, 802.11b/802.11g products 
are designed for use only in specific countries or regions, 
and are not allowed to be operated in countries or regions 
other than those of designated use.

As a user of these products, you are responsible for 
ensuring that the products are used only in the countries 
or regions for which they were intended and for verifying 
that they are configured with the correct selection of 
frequency and channel for the country or region of use. 
Any deviation from permissible settings and restrictions in 
the country or region of use could be an infringement of 
local law and may be punished as such.
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RTC caution
CAUTION : Danger of explosion if battery is incorrectly replaced. 
Replace only with the same or equivalent type recommended 
by the manufacturer. Discard used batteries according to the 
Manufacturer’s instruction.

Belgium

For private use outdoors in public spaces, no registration is 
necessary for distances less than 300 m. For distances greater 
than 300 m, you must register with the Belgian Institute for Postal 
services and Telecommunications (BIPT). For commercial use 
outdoors, you must obtain a license from the BIPT. For registration 
or licensing, please contact the BIPT.

For other languages, refer to the corresponding manuals.

France

The low band 5.15 - 5.35 GHz is for indoor use only.
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India only
For more information on safe disposal and recycling visit our 
website www.samsung.com/in or contact our Helpline numbers - 
18002668282, 180030008282.

This product is RoHS compliant.

WEEE symbol information
Correct disposal of this product (Waste Electrical & 
Electronic Equipment)

(Applicable in countries with separate collection 
systems)

This marking on the product, accessories or literature 
indicates that the product and its electronic accessories (for 
example, charger, headset, USB cable) should not be disposed of 
with other household waste at the end of their working life.

To prevent possible harm to the environment or human health 
from uncontrolled waste disposal, please separate these items 
from other types of waste and recycle them responsibly to 
promote the sustainable reuse of material resources.

Household users should contact either the retailer where 
they purchased this product, or their local government office, 
for details of where and how they can take these items for 
environmentally safe recycling.

Business users should contact their supplier and check the terms 
and conditions of the purchase contract. This product and its 
electronic accessories should not be mixed with other commercial 
wastes for disposal.

http://www.samsung.com/in
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USA only

This Perchlorate warning applies only to primary CR (Maganese 
Dioxide) Lithium coin cells in the product sold or distributed ONLY 
in California USA.  
“Perchlorate Material- special handling may apply, see  
www.dtsc.ca.gov/hazardouswaste/perchlorate.”  
Dispose unwanted electronics through an approved recycler.  
To find the nearest recycling location, go to our website:  
www.samsung.com/recyclingdirect  
Or call, (877) 278-0799. 

For battery recycling go to call2recycle.org; or call 1-877-723-1297.

Warning : This product contains chemicals known to the state of 
California to cause cancer and reproductive toxicity.

Correct disposal of batteries in this product

(Applicable in countries with separate collection 
systems)

This marking on the battery, manual or packaging 
indicates that the batteries in this product should not be disposed 
of with other household waste at the end of their working life. 
Where marked, the chemical symbols Hg, Cd or Pb indicate 
that the battery contains mercury, cadmium or lead above the 
reference levels in EC Directive 2006/66. If batteries are not 
properly disposed of, these substances can cause harm to human 
health or the environment.

To protect natural resources and to promote material re-use, 
please separate batteries from other types of waste and recycle 
them through your local, free battery return system.

http://www.dtsc.ca.gov/hazardouswaste/perchlorate.
http://www.samsung.com/recyclingdirect
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Samsung package Take-Back 
program
In partnering with select recyclers, Samsung offers packaging 
take-back at no cost to you.

Simply call the following number for the locations nearest you.

CRT Processing, LLC

(877) 278-0799

Kathy Severson – Logistics contact

Dispose unwanted electronics through an approved recycler.

To find the nearest recycling location, go to our website:

www.samsung.com/recyclingdirect Or call, (877) 278-0799

http://www.samsung.com/recyclingdirect
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